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Overview

Overview

Standard reports that are provided with the Deltek Vision software are designed to meet most of your
business needs. In addition, you can use Microsoft SQL Server® Reporting Services (SSRS) and its report
writing tools to create Vision custom reports.

With SSRS's Report Builder or Business Intelligence Development Studio (also known as BIDS or Report
Designer), you can create custom reports using Vision's report model or report templates. You can also
open a copy of a Vision standard report in BIDS and modify it to create a custom report.

This guide provides information for the following tasks that are necessary to create, deliver, and generate
Vision custom reports:

Task Description

1 Decide which report writing tool to use to create custom reports.
2 Install the required SSRS report writing software.
3 Give the appropriate users who will create custom reports access to SSRS and its

report writing software.

4 = Load the Vision report model into SSRS. Report models are used when you
create custom reports with Report Builder.

= Load the Vision report templates on the workstations of the appropriate users
who will create custom reports with BIDS (Report Designer).

5 = Access the Vision report model in Report Builder to create custom reports.
= Access the Vision report templates in BIDS to create custom reports.

= Create a custom report from a copy of a Vision standard report in BIDS.

6 Save custom reports to the appropriate folder on your application server.
7 Load custom reports into Vision via Vision Utility » Report Administration.
8 Set up parameters for a custom report in Vision Configuration » General » Custom

Report Options.

9 In Vision Role Security Configuration, set up access rights to give the appropriate
Vision users the ability to generate and print specific custom reports from the Vision
Reporting menu.

10 From the Vision Reporting menu, select a custom report, choose options, generate
the report, and then preview and print it.

This guide also provides a description of Vision fields that are available in the report models from which
you create custom reports with Report Builder.

Specific instruction on how to create and design Vision custom reports is beyond the scope of this
document. For detailed information and training on how to design a Vision report with Report Builder or
BIDS, Deltek offers report writing classes through Deltek University.

See http://www.deltek.com/services/deltekuniversity for class offerings.

Custom Reports and Microsoft SQL Server® Reporting 1
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Overview

The Deltek Consulting Services Group provides assistance with custom reports. Contact them at
CustomServices@Deltek.com for more information about the services that they provide. Assistance to
create custom reports is not covered by your Vision Ongoing Support Plan (OSP).

About This Guide

Deltek revises documents regularly to provide the most up-to-date technical information and instructions.
Visit the Knowledge Center at the Deltek Customer Care Connect site, https://support.deltek.com, to
determine whether or not your copy is the latest copy and to download the most recent copy if necessary.

Adding Custom Notes to This Guide

If you would like to add custom notes to this guide that are specific to your company, Adobe® Reader® X
provides this ability. If you do not already use Adobe Reader X, you can download it here free from
Adobe.
To add a custom note using Adobe Reader X, complete the following steps:
1. On the Reader toolbar, click Comment at the far right.
2. Inthe Annotations pane that displays, click v Sticky Note. The cursor changes to match the
button.

3. Position the cursor at the location in the guide where you want the note to appear, and click. A
note icon is inserted at the location and a text box pops up.

4. Enter your information in the text box.
Continue adding notes as needed.

6. Save the document.

Deltek recommends that you save the document to a slightly different filename so as to keep the
original file from being overwritten.

When you read the document, cursor over a note icon to see the information. Double-click a note icon to
edit the information.

Custom Reports and Microsoft SQL Server® Reporting
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If You Need Assistance

If You Need Assistance

If you need assistance installing, implementing, or using Vision, Deltek makes a wealth of information and
expertise readily available to you.

Customer Services

For over 20 years, Deltek has maintained close relationships with client firms, helping with their problems,
listening to their needs, and getting to know their individual business environments. A full range of
customer services has grown out of this close contact, including the following:

= Extensive self-support options through the Customer Care Connect Web portal.
=  Phone and email support from Customer Care analysts

= Technical services

= Consulting services

= Custom programming

= Classroom, on-site, and Web-based training

Find out more about these and other services from the Customer Care Connect site.

Customer Care Connect Site

The Deltek Customer Care Connect site is a support Web portal for Deltek customers who purchase an
Ongoing Support Plan (OSP).

The following are some of the many options you have at the Customer Care Connect site:
= Download the latest versions of your Deltek products
= Search Deltek’s knowledge base

= Ask questions, exchange ideas, and share knowledge with other Deltek customers through the
Deltek Connect Customer Forums

= Display or download product information, such as release notes, user guides, technical
information, and white papers

= Submit a support case and check on its progress

= Transfer requested files to a Customer Care analyst

= Use Quick Chat to submit a question to a Customer Care analyst online

= Subscribe to Deltek communications about your Deltek products and services

= Receive alerts of new Deltek releases and hot fixes

If you need assistance using the Customer Care Connect site, the online help available on the
site provides answers for most questions.

Custom Reports and Microsoft SQL Server® Reporting
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Access Customer Care Connect

To access the Customer Care Connect site, complete the following steps:

1. Go to https://support.deltek.com.

2. Enter your Customer Care Connect Username and Password.
3. Click Log In.

If you do not have a username and password for the Customer Care Connect site, contact your
firm’s Vision administrator.

If you forget your username or password, you can click the Account Assistance button on the
login screen for help.

Additional Documentation

The following table lists the additional Deltek documentation related to Vision custom reports and SQL
Server Reporting Services. You can download this PDF file from the Deltek Customer Care Connect site.

Document Name Description

Deltek Vision Microsoft SQL Server This guide explains the Microsoft SQL Server

Reporting Services Licensing FAQ Reporting Services licensing implications for
Vision.

Custom Reports and Microsoft SQL Server® Reporting
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Ways to Create Vision Custom Reports

Whether you use SSRS Report Builder or BIDS to create a custom report depends on your reporting
needs and report writing skill level. The following table provides information to help you determine the
reporting tool to use to create custom reports.

BIDS 2008

Report Builder 2.0 S Wi el (REgei

Templates or Start with a
Skill Requirements and Use the Vision Report Copy of a Standard Vision
Reporting Capabilities Model Report

Skill Requirements:

Report writing tool skill level Basic Advanced

Relational database structure No Yes
knowledge required

Reporting Capabilities:

Create ad hoc reports Yes No
Create table, matrix, and chart | Yes Yes
reports

Apply grouping and formulas Yes (at design time only) Yes
in reports

Apply sorting Yes Yes
Apply filtering No Yes
Apply advanced reporting No Yes

features, including complex
queries, advanced charting,
parameters, drill downs,
subreports, and so on

Combine tables, lists, and No Yes
charts in the same report

Include Vision user-defined No Yes

fields in reports Yes, with Deltek
customization

Include a Sorting/Grouping tab | No Yes, if you modify special
or Columns tab on the report tags in SQL statements.

Options dialog box in Vision
Reporting for custom reports

Custom Reports and Microsoft SQL Server® Reporting
Services
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Know more.
Do more.™

Delte

Skill Requirements and
Reporting Capabilities

Report Builder 2.0

Use the Vision Report
Model

BIDS 2008

Use Vision Report
Templates or Start with a
Copy of a Standard Vision
Report

Create a custom report
Options dialog box to display
in Vision Reporting for a
custom report

No

No

Access the Vision database
with the reporting tool

You access only Vision
fields that are contained in
the report model.

You access the full Vision
database.

of Vision

Launch the reporting writing Yes. No
application within Vision You can add Report Builder

to the Vision Navigation

menu.
Deploy custom reports outside | No No

Custom Reports and Microsoft SQL Server® Reporting
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Software Requirements for Creating Custom Reports

Software Requirements for Creating Custom Reports

Microsoft SQL Server®Reporting Services Report Writing Tools

Report Builder 2.0 and BIDS 2008 are the Microsoft SQL Server Reporting Services (SSRS) 2008 report
writing tools that are supported for creating Vision custom reports. Install these tools on the machines
from which you will create or edit Vision custom reports. These machines are typically workstations,
rather than Vision web servers.

The following are not supported for creating Vision custom reports:
=  Report Builder 3.0

=  Report Builder 1.0

=  BIDS 2012, which is provided with SSRS 2012

= BIDS 2008 R2, which is provided with SSRS 2008 R2
=  BIDS 2005, which is provided with SSRS 2005

If you try to load a custom report into Vision that was created with an unsupported version of BIDS or
Report Builder, you will receive a “SQL Report Error loading report” error message.

To determine whether or not a custom report was created with the supported BIDS 2008 version, open an
.rdl file for a custom report, and look at the header lines. If the report was created with BIDS 2008, it will
have 2008 in the path. If it has 2010 in the path, it was created with BIDS 2008 R2 or BIDS 2010 (not
supported). The following are header line examples:

= The header line in an .rdl report file that is created with BIDS 2008 (supported) is:

<Report xmlns:rd="http://schemas.microsoft.com/SQL Server/reporting/reportdesigner”
xmlIns="http://schemas.microsoft.com/sqglserver/reporting/2008/01/reportdefinition">

= The header line in an .rdl report file that is created with BIDS 2008 R2 and BIDS 2010 (nhot
supported) is:

<Report xmIns:rd="http://schemas.microsoft.com/SQLServer/reporting/reportdesigner"”
xmlns="http://schemas.microsoft.com/sqglserver/reporting/2010/01/reportdefinition">

Only the users who create custom reports need Report Builder or BIDS installed on their
machines. Vision users who only need to open, generate, and print custom reports (but not
create them) do not need to install these report writing tools.

To support the ability to open, generate, and print custom Vision reports, the Vision database
and report servers must have one of the supported or compatible versions of Microsoft SQL
Server installed. These include SQL Server 2012, SQL Server 2008 R2, or SQL Server 2008.
For a full list of Microsoft SQL Server releases (R), service packs (SP), and cumulative updates
(CU) that are supported or compatible with Vision, see the Deltek Product Support Compatibility
Matrix. You can download this PDF document at the Deltek Customer Care Connect site:
https://support.deltek.com.

Custom Reports and Microsoft SQL Server® Reporting
Services
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Software Requirements for Creating Custom Reports

Supported Writing Tools and Installation Information

The following table provides more information about the installation of each of the SSRS 2008 report
writing tools that are supported for creating Vision 7.0 custom reports:

Supported
Microsoft SSRS

2008 Report
Writing Tool

Report Builder 2.0

Installation Information

The following are ways that you can acquire Report Builder 2.0:

= As a free, stand-alone download from the following Microsoft link:
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=

1932
= With the installation of SQL Server 2008 SP1 from the following
Microsoft link:

http://www.microsoft.com/en-
us/download/details.aspx?id=20302#overview

This service pack applies for any of the SQL Server 2008 editions.
However, you must use the Workgroup, Standard, or Enterprise edition
because these editions support the use of report models, which are
required to create Vision custom reports.

SQL Server 2008 Express and Express with Advanced Services do not
support report models, which are required to create Vision custom
reports.

Report Builder, a Web application, is installed on your SSRS report server. It
downloads to users' workstations via a ClickOnce application when they open it.
To create custom reports with Report Builder, users must have the following
installed on their workstations:

= NET Framework 2.0

= Microsoft Internet Explorer 6.0 or later

Microsoft
Business
Intelligence
Development
Studio 2008

(BIDS, which is
also referred to as
Report Designer)

The following are ways that you can acquire BIDS 2008:

= BIDS 2008 is included with the SQL Server 2008 Express with Advanced
Services edition.

This is a free download from the following Microsoft link:
http://www.microsoft.com/en-gb/download/details.aspx?id=1842

During this installation, select only the Business Intelligence
Development Studio check box in the Shared Features section of the
SQL Server 2008 Setup dialog box. After you install BIDS, apply SQL
Server 2008 Service Pack 3, and then install the Cumulative Update 6
for Service Pack 3. The Microsoft links for this software are included in
the next section of this guide.

= BIDS 2008 is included with the SQL Server 2008 Standard, Workgroup,
Developer, and Enterprise editions.

= BIDS is a plug-in with Microsoft Visual Studio 2008 Professional or Team
System (from the SQL Server Workgroup edition).

Custom Reports and Microsoft SQL Server® Reporting 8
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For more information about SSRS licensing, see the Vision 7.X SQL Reporting Services (SRS

Licensing) FAQ document. You can download it from the Deltek Customer Care Connect site at
https://support.deltek.com.

Deltek can also arrange for implementation services support from your Deltek consultant.

If you have any additional questions, please contact Deltek Customer Care at 877.457.7765.

Current Updates for Microsoft SQL Server 2008

If you are using BIDS 2008 from a SQL Server 2008 installation, Deltek recommends that you update
your installation to the version supported by Deltek for Vision 7.0, which is SQL Server 2008 SP3 + CU6.
The Microsoft links for each are:

= SQL Server 2008 Service Pack 3:

http://www.microsoft.com/en-us/download/details.aspx?id=27594

= Cumulative update package 6 for SQL Server 2008 Service Pack 3:
http://support.microsoft.com/kb/2715953

(CU) that are supported or compatible with Vision, see the Deltek Product Support Compatibility
Matrix. You can download this PDF document at the Deltek Customer Care Connect site.

For a full list of Microsoft SQL Server releases (R), service packs (SP), and cumulative updates

Custom Reports and Microsoft SQL Server® Reporting 9
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Report Builder 2.0

Report Builder 2.0

Use Report Builder 2.0 to create simple, ad hoc custom Vision reports. You can create table, matrix, and
chart reports. To create a report, you select the Vision report model and then drag and drop Vision fields
into the report design area. You can filter, group, and sort report data. You can add formulas and
parameters to your reports.

Configure Report Builder Access

To configure your SSRS report server for users to access Report Builder, follow Microsoft's
recommendations in the following article:

SQL Server 2008: http://msdn.microsoft.com/en-us/library/ms365173(v=sgl.100).aspx

To allow users to access the SSRS report server to create custom reports, you must grant them the
following SSRS permissions:

= At the server level, users must be system users.

= At the folder level, users must be granted browser and Report Builder access.

can access all the Vision database fields included in the Vision report model, which is a subset
of the Vision database. Vision role security does not apply when accessing the Vision database
to create custom reports.

Users who have access to your SSRS report server to create custom reports with Report Builder

Non-Domain Clients

SSRS requires Windows Integrated Authentication. Non-domain clients (clients who do not run Active
Directory or have a Windows domain) must do the following:

= Create alocal account on the SSRS report server for each user who creates custom reports.

=  Grant the necessary reporting services permissions (see the previous "Configure Report Builder
Access" section) to those who create custom reports.

How to Start Report Builder

You provide one of the following ways for users to start Report Builder from their workstations:
=  AURL link
= SSRS Report Manager

Deltek does not support SharePoint Integrated Mode for SSRS Vision.

More information on how users start Report Builder is available at the following link:

http://msdn.microsoft.com/en-us/library/ms345245.aspx (SQL Server 2008)

Custom Reports and Microsoft SQL Server® Reporting 10
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" Report Builder 2.0

Add Report Builder to the Vision Navigation Menu
Individual users who will create custom reports with Report Builder can add a link to Report Builder
directly on the Vision Navigation menu.
To add Report Builder as a separate menu item on the Vision Navigation menu, complete the
following steps:

1. Open Vision, and at the bottom of the Navigation menu, click the Designer icon.

Hid & :

f Navigation

e  Lcltek Vision® Deltek Soumore

nfo Center |

5
31 ies
T —
.
Planning
iy

illing

a Transaction Center

- 1]

uman Resources

F:'@ Time & Expense |

: y
:
L —
.
= Reporting
|

) utilities

““* Configuration

™~

Designer icon that opens the Navigation Menu Designer dialog box

Custom Reports and Microsoft SQL Server® Reporting 1
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2. On the left side of the Navigation Menu Designer dialog box, right-click the Navigation menu item
above or below which you want to add Report Builder.

In the following example, the Reporting menu is selected.

“ Navigation Menu Designer ﬂ
Right-click over the navigation tree below to see Menu ID | Reporting | | Use Defined Node
available options,
Menu Label |Rep0rting |
2 Acti [ Parent
T
St Calendarctivities el sl
L3 Proposals r—Action Options
EF Planning
[7] Biling
"2 Transaction Center
Z12 Accounting
57 Human Resources
S Time & Expense
@ Purchasing
& Inventory
o
o Uilities Cut
A Config Paste Before
Paste After
Insert Before E
Inzert After Ok | [ cancel | [ Help. |
Indent
Qutdent
Delete

3. On the shortcut menu, click Insert before or Insert after.

In this example, the Report Builder menu item (a parent menu item) is inserted after the
Reporting menu item.

*Navigation Menu Designer 1'

Right-click over the navigation tree below to see Menu ID | Reporting | "] Use Defined Mode
available options,

Menu Label | Reporting |

3]

p . Acki F. k
Calendaractivities cuon | ELE i

Proposals —#ction Options
Flanning

Billing

Transaction Center
. Accounting

e

e

3]
V8IS bt B0 80 2k 6

Human Resources

HEHBHEB

i Time & Expense
i@ Purchasing
@ Inventory
.o P —
* Cut

e Utilities
A Confi Paste Before
Paste After

Insert Before =
Insert After Ok H Cancel ][ Help

Indent
Outdent

Delete

On the Navigation Menu Designer dialog box, the Menu ID field is automatically populated.
Deltek recommends that you do not modify it.

Custom Reports and Microsoft SQL Server® Reporting
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4. Inthe Menu Label field, enter Report Builder or the name that you want to see in the Vision
Navigation menu to open the Report Builder software.

“ Navigation Menu Designer ﬂ

Right-click over the navigation tree below to see Menu 1D | A595141F?1624SSDBA846C9CE409AE?| [¥] Use Defined Mode
available options,

Menu Label | Report Builder| |

&, Info Center

St Calendarctivities

Action | Parent -

3 Proposals

HEHBE

—fckion Cptions
™ Planning

[ Biling
2 Transaction Center

H H

Accounting

H H

5 Human Resources
5 Time & Expense
@ Purchasing

& Inventory

HEHEE

& FRepoarting
new node

o Utilities

A Corfiguration

[ O | [ cancel. | [ Help. |

5. Leave the remaining fields on the Navigation Menu Designer dialog box as they are (Parent
should be entered in the Action field), and click OK. The Navigation Menu Designer dialog box
closes.

6. Atthe bottom of the Vision Navigation menu, click the Designer icon to open the Navigation Menu
Designer dialog box again. Now you see the Report Builder parent item listed with the other menu
items on the left.

“ Navigation Menu Designer ﬂ

Right-click over the navigation tree below to see Menu 1D | InfoCenter | "] Use Defined Mode
available options,

Menu Label | Infa Center |

& Info Cenker

5% Calendarfactivities

Action | Parent hd

HEHBA

Proposals

—fckion Cptions
™ Planning

H H

Billing

8
e
2y
=

e

1 Transaction Center

. Accounting

L% Hurnan Resources

HEHE

i Time & Expense
## Purchasing
& Inventory

Reporting
< Report Builder >
oo Ltilities

A Corfiguration

e e ) R

7. Repeat steps 2 through 5 to enter a Report Builder child menu item under the Report Builder
parent menu item (insert the new menu item after Report Builder, and enter the Report Builder
menu label). At this point, you cannot change the Action field, so leave it as Parent, and click
OK. The Navigation Menu Designer dialog box closes.

8. Click the Vision Designer icon to open the Navigation Menu Designer dialog box again. This time
you see both of the Report Builder menu items.
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9. Right-click the second occurrence of Report Builder, and select Indent from the short-cut menu.
This creates the child menu item.

10. From the drop-down list in the Action field, select HTTP.

11. In the Open field in the Action Options section, enter the following:

http://<your S5RS Server name=/ReportServer/ReportBuilder.application

i

“Mavigation Menu Designer

Right-click over the navigation tree below to see Menu ID | CCCFD15447AD4E4783C485CA37ERLC |
available options.

Menu Label | Report Builder |

B Info Center
St Calendarjactivities

Proposals r—#Action Options
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Action [HrTP =

o gl Open |htt|3:,|’,|’<:your 33RS Server name ={ReportServer/ReportBuilder . applicati |
-] Billing

Transaction Center Arguments
Accounting

Human Resources i
Time & Expense ) Mew Window
Purchasing

Open Options

EEEEEEE
V@ &

@ application Frame

Inventory

¢ ESEE

Reparting

OEEEHBEBE

Report Builder
Report Builder

Utilities

A Configuration

HE
@

T O e G e |

12. Click OK to save these settings.
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13. Exit and restart Vision for Report Builder to display on the Navigation menu.

o Deltek Vision® Deltek &sumore

I m Calendar/ Activities

ek ]
| -a- Proposals
ﬁ Billing

| E Transaction Center

Human Resources

Fé Time & Expense

& Inventory

»
r Reporting

;
" Report Builder

#® utilities

S Configuration

To add a Report Builder menu item within the existing Vision Reporting menu item, create an
indented child menu item within the Reporting parent menu item (similar to steps 8 through 13).

Report Builder and the Vision Report Model

Vision comes with a report model—DeltekVisionReportModel.smdl—that you can use in Report Builder
to create custom Vision reports. With the report model, you can create project, accounting, and Customer
Relationship Management reports.

The Vision report model defines the Vision database in more user-friendly terms and eliminates the need
for those who create reports to have in-depth database knowledge. The model makes it easier to find and
select the information from your Vision database to include on custom reports. When you use the report
model, queries are automatically generated to retrieve data from your Vision database.

The Vision report model contains:

= Data source information that is required to connect and retrieve information from the Vision
database.

= A preselected group of Vision database tables and relationships. These are Vision entities and
fields that you can add to a custom report. Database fields and tables have easy-to-understand
business names and are grouped in the most appropriate way to make it easy to create the
reports that you need.

For descriptions of the Vision database fields that are included in the Vision report model, see the
"Contents of the Vision Report Model" section on page 49 of this guide.
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The Vision report model does not include user-defined fields. If you want to include user-defined
fields in your custom reports, contact CustomServices@Deltek.com for information about
Deltek's assistance with custom reports.

Users who have access to your SSRS report server to create custom reports with Report Builder
can access all the Vision database fields included in the Vision report model, which is a subset

of the Vision database. Vision role security does not apply when accessing the Vision database
to create custom reports.

For more information about report models, see the following Microsoft link:

http://msdn.microsoft.com/en-us/library/ms159752(v=sql.100).aspx.

Load the Report Model onto your SSRS Report Server

You must load the Vision report model onto your SSRS report server before users can access it in Report
Builder.

Because the Vision model file is large, you must first modify the Web.config file to prevent a "Maximum
request length needed" error when you load the report model.

While you load the report model, Vision users will not be able to run any reports.

To modify the Web.config file, complete the following steps:

1. Use Windows Explorer to navigate to the Web.config file on your SSRS report server at the
following location:

C:\Program Files\Microsoft SQL Server\MSRS10.SQL2008\Reporting Services\ReportServer.
2. Make a backup copy of the Web.config file.

3. Open the Web.config file in the ReportServer folder with NotePad, and navigate to the
<system.web> section of the file.

4. In the <system.web> section, navigate to the <httpRuntime execution Timeout = "9000" /> line.
Add maxRequestLength="151200" to the end of the line so it now reads:
<httpRuntime executionTimeout = "9000" maxRequestLength="151200" />.

6. Save the Web.config file.

To load the Vision report model, a system administrator completes the following steps:
1. From the Vision Navigation menu, click Utility » Report Administration.

2. Onthe Load Reports tab, the Location of reports on application server field displays the path
to the Vision Reports folder on your Vision application server—C:\Program
Files\Deltek\Vision\Reports.

3. From the drop-down list in the Type field, select Report Models.
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B Report Server: CAMQARPTLUNA (Root Folder: VisionEuropa)

Load Reparts |Rep0rt Printers |Current Activity| Report Logging |Database Cleanup

Location of Reports on Application Server | C:\Program Files\DelkekiVision\Reports |
Type | Repart Models - | Repart Mame | |
[ Delete Existing Reports in Each Folder Before Loading | Load Report Files | | Check Report Wersion |
Loaded Reports =
e
Report Path 4 Lookup Type 49| Group Twpe & Warsion = =
} | fStandardfaccounting Cash Flow Forecast 7.0.0.416
[otandard/Accounting/ Cash Journal 7.0.0.416
[atandard/Accounting/Cash Receipt CashReceipk 7.0.0.418
[atandard/AccountingCash Staterment 7.0.0.418
J5tandardjAccounting CashReceiptSummary 7.0.0.416
Jstandardjaccounting/Chart of Accounts Audit Account 7.0.0.416 E

Ready

4. If you previously loaded a report model, select the Delete existing reports in each folder
before loading check box, so that old models are removed first. If you did not previously load a
report model, clear the Delete existing reports in each folder before loading check box.

5. Click the Load Report Files button. When the process completes, you receive a message that
identifies the number of items loaded.

This loads the report model into the SSRS database and the appropriate files are loaded into
the appropriate IIS Virtual directory that points to their installation in C:\Program
Files\Deltek\Vision 7.0\Reports\Custom.

Multiple Vision Databases

If you have multiple Vision databases and you want to use the Vision report model with each Vision
database, you must load the Vision report model for each database. In Vision, open each database, and
perform the steps in the previous section of this guide to load the report in Utilities » Report
Administration.

Move a Vision Database

After you load the report model to your report server, if you move a Vision database, you must load the
report model again by opening the appropriate database in Vision and loading the report model in
Utilities » Report Administration.

Access the Report Model in Report Builder

The following are the steps to access the Vision report model to create a custom report with Report
Builder. These steps assume that a Vision system administrator has:

= Completed the steps in the "Software Requirements" section of this guide.

= Loaded the Vision report model per the "Vision Report Model" section of this guide.
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To access the Vision report model in Report Builder, complete the following steps:

1. Open Report Builder with a link determined by your Vision system administrator.

E;-..
2. On the main Report Builder window, click @ and then click New in the pane on the left.

it Recent Documents
| MNew
| Cash Journal

iy Client List
'J,f Open

Save

H Save As

2] Options | ¢ Exit Report Builder |

3. Inthe Report Data pane on the left of the next window, click New » Data Source.

Report Data

Mew x| Edit... /A&

Data Source...

Dataset...
Parameter...

Image...

4. On the Data Source Properties window, complete the following entries, and then click OK.
= Select the Use a shared connection or report model option.

= Click the Browse button to navigate to and select the Vision report model on the Vision
report server.
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5. Inthe data region of the report, click the Table or Matrix icon to add data to the report using the
wizard.
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The data region can have the following controls:

= Tabular (columnar) — This creates a report with a set number of rows and columns of
information.

= Matrix (cross-tab or pivot table) — This creates a report with rows and columns that are
determined by the data returned when you run the report.

= Chart — This creates a report with a column, bar, area, line, pie, or doughnut graphic.
6. As you go through the wizard, you:

= Build a query to specify the Vision data that you want from the data source.

= Arrange fields to group data in rows and columns.

= Choose the layout for displaying subtotals and grand totals and expanding and collapsing
groups.

= Choose styles for fonts and color schemes.

Specific instruction on how to create and design Vision custom reports is beyond the
scope of this guide. For further instruction on how to design your report, see Microsoft's
Report Builder help. You can also check the Deltek Web site at

http://www.deltek.com/services/deltekuniversity for custom reporting classes offered
through Deltek University.

7. After you complete the wizard, to save your report, click @ and then click the Save As
command. On the Save As dialog box, enter the file name for the report (The Save as type is
Report files [*.rdl]).

See the "Vision Application Server Location for Custom Reports"” section on page 39 of this guide
for more information about where to save custom report .rdl files so they can be successfully
loaded into Vision and accessed from the Vision Reporting menu.

You must use the Save to File option when you save a report file in Report Builder.
Then when you use Vision's Report Administration utility, the custom report is loaded

into SSRS and Vision to display on a Vision Reporting submenu.

In Report Builder, if you save a report with Save, instead of Save to File, the report is
deployed to SSRS and no .rdl file is created. The report will be available in Report
Manager (SSRS's Web interface), but it will not be available in Vision.
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Business Intelligence Development Studio (BIDS)

Microsoft's Business Intelligence Development Studio (BIDS) is also referred to as Report Designer. Use
it to create both simple and complicated reports. It is a full-featured, advanced report writing tool. You can
create tabular, matrix, chart, and free-form reports. You can create complex queries, advanced charts,
parameters, drill downs, and subreports. You can create expressions to specify report data.

To create custom reports with BIDS, you must install BIDS 2008 locally on a report writer's workstation
(with the appropriate licensing).

To allow report writing users access to the SSRS report server, you must grant them the following SSRS
permissions:

= At the server level, users must be system users.

= At the folder level, users must be granted browser and Content Manager access.

Users who have access to your SSRS report server to create custom reports in BIDS can
access all fields in your Vision database. Vision role security does not apply when accessing the

Vision database to create custom reports.

Non-Domain Clients

SSRS requires Windows Integrated Authentication. Non-domain clients (clients who do not run Active
Directory or have a Windows domain) must do the following:

= Create alocal account on the SSRS report server for each user who creates custom reports.

= Grant the necessary reporting services permissions (see the previous section) to those who
create custom reports.

BIDS and Vision Report Templates

Overview

Vision comes with report templates that you can use to create custom reports in BIDS. The templates
provide formatting for custom reports that is similar to the formatting of Vision standard reports.

You copy the template files to the workstation of users who will be creating custom reports. Then when
users launch BIDS, the Vision templates display in the list of templates. Users can also create custom
reports with BIDS by using the Vision report templates located directly on your SSRS report server
(without copying the template files to a workstation).

Template Files

The template files for custom reports are:
= VisionTemplateAudit.rdl
= VisionTemplateAuditDetail.rdl

= VisionTemplateCustomReport.rdl

= VisionTemplateLandscape.rdl — Use this for column selection reports that must be printed using
the landscape orientation. Report properties are set for this, so you do not need to modify them.

= VisionTemplatePortrait.rdl — Use this template to create column selection reports.
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= VisionTemplatePostingLog.rdl

= VisionTemplateSubReport.rdl — Use this only to create a subreport. Vision invoices are good

examples of reports that use subreports. Each section of a single invoice (report) is created by
using subreports.

= VisionTemplateTransactionList.rdl

[T veonTemplatr_itod [Bosign] 5 - x
&j Desgn | 4 Prevew
5 [ Budtor P
= | Perameten
 Images afxprn | slxprn
E O De [LabelPortraitTemplate] b
aEAps
Expre
. —
i) Pow Grougs ) Column Grous =
[ [graus) I3
|= {PeninTabls_Dataik_Groag |=]

1] Feepart Dk (5 Toodow

VisionTemplatePortrait.rdl file when you open it in BIDS

When you install Vision, the template files are installed on your Vision application server in the following
location:

C:\Program Files\Deltek\Vision\Reports\Template

Load the Templates on a Workstation

To create a custom report on the workstation of a user who writes reports with BIDS, copy the .rdl
template files (listed in the previous section) to the following location on the user’s workstation:

C:\Program Files\Microsoft Visual Studio
9.0\Common7\IDE\PrivateAssemblies\Projectltems\ReportProject

After you copy the .rdl template files to a workstation, when you launch BIDS and select Business
Intelligence Projects, the Vision templates display in the list of templates as in the following screen shot.
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My Templates

_;:'; Search Online Templates. ..

Create a new report using Repark Wizard |

Mame: Reportl . rdl |

add H Cancel ]

Method One

One way to copy the .rdl template files to a user's workstation is to allow appropriate users access to the
Templates folder on your Vision application server. You can make the Templates folder shared and
accessible so that report writing users can easily copy the .rdl template files to their workstations.

Method Two

You can also load the .rdl template files to your SSRS report server from the Vision application server
with the Vision Report Administration utility. When you use this utility, the .rdl template files are loaded
onto your SSRS report server in C:\Program Files\Deltek\Vision\Reports\Custom. You can then share
the Custom folder so report writing users can access it and copy the template files to their workstations.

When you run the Report Administration utility, Vision users cannot access any reports.

To load the .rdl template files from your Vision application server location to your SSRS report
server location, complete the following steps:

1. From the Vision Navigation menu, click Utility » Report Administration.

2. Onthe Load Reports tab, the Location of reports on application server field displays the path
to the Vision report location—C:\Program Files\Deltek\Vision\Reports.

3. From the drop-down list in the Type field, select Report Models.
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B Report Server: CAMQARPTLUNA (Root Folder: Visionl

Load Reparts |Rep0rt Printers |Current Activity| Report Logging |Database Cleanup

Europa)

Location of Reports on Application Server

| C:\Program Files\DelkekiVision\Reports

Type | Repart Models - | Repart Mame |

[ Delete Existing Reports in Each Folder Before Loading

| Load Repart Files

| | Ccheck Report version |

Loaded Reports =
| | | | | e
Report Path 4+ Lookup Type 4 Group Type | Warsion A =
' II'Standard.l'P.chuntlng.l'cashF|DwFDreCast R T S T
[otandard/Accounting/ Cash Journal 7.0.0.416
[atandard/Accounting/Cash Receipt CashReceipk 7.0.0.418
[atandard/AccountingCash Staterment 7.0.0.418
J5tandardjAccounting CashReceiptSummary 7.0.0.416
Jstandardjaccounting/Chart of Accounts Audit Account 7.0.0.416 E
Ready

4. |If you select the Delete existing reports in each folder before loading check box, Vision
deletes all reports of the type that you selected that are currently loaded; then it loads the reports
from the application server Reports folder.

5. Click the Load Report Files button.
6. When it completes, you receive a message that identifies the number of items loaded.

This loads the report templates into the SSRS database, and the appropriate files are loaded
into the appropriate 1S Virtual directory that points to their installation in C:\Program
Files\Deltek\Vision\7.0\Reports\Custom.

Access the Report Templates in BIDS

After the Vision report templates are loaded onto a workstation, when you launch BIDS and select

Business Intelligence Projects, you see a list of the BIDS templates from which you can create new
reports.

You cannot use the Vision report templates with the BIDS Report Wizard.

To access the Vision report templates to create a custom report, you complete three procedures
to:

1. Create a solution and report server project.
2. Create the shared data source.

3. Select a Vision template and start to create a custom report.

To create a solution and report server project, complete the following steps:

1. On your workstation, open the BIDS software. Click Window Start » All Programs » Microsoft
SQL Server 2008 » SQL Server Business Intelligence Development Studio.
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Click File » New » Project.
Select Business Intelligence Projects.

In the Templates section of the New Project dialog box, click Report Server Project to highlight
it.

In the Name field, enter a name for the report server project. For example, you could name it
VisionCustomReports.

A report server project contains:
= A data source (information about a connection to a data source for your report).
= Any custom reports that you create with the data source.

In the Location field, enter the path on your workstation where you want to store the report
server project.

In the Solution Name field, enter a name for the solution in which this report server project will be
contained. (Solutions can contain multiple projects.)

Click OK.

In the Solution Explorer pane, you now see the solution that you just created. (To display the
Solution Explorer pane, click View » Solution Explorer.)

To create the shared data source, complete the following steps:

1.

In the Solution Explorer pane, below your solution, right-click Shared Data Sources, and from
the shortcut menu, click Add New Data Source.

On the General tab of the Shared Data Source dialog box, in the Name field, enter
DefaultDataSource, which is the name of the Vision data source.

All of the Deltek report templates look at the data source called DefaultDataSource. If

you name it something else, you will receive an error when you select the Data tab of
the Design window. When you receive the error, click OK and then modify the dataset
to use your connection instead. You must do this for each dataset.

Also, when you rename an existing data source, if you previously used the data source
for a report, the report will be broken and you need to edit the report query to reference
the new data source name.

Click the down arrow in the Type field and select Microsoft SQL Server from the drop-down list.

Click the Edit button beside the Connection string text box to open the Connection Properties
dialog box where you can create the connection string to your Vision database.

a) Select the server on which your Vision database resides.

b) Deltek recommends that you use Windows authentication to log on to the server. This
prevents users from accessing information via BIDS that they should not access. If you use
SQL Authentication and save the password, the password is saved as plain text and can be
seen with NotePad.

c) Enter the Vision database name to connect to.
d) When you finish, click OK.

On the Credentials tab of the Shared Data Source dialog box, enter the credential information for
the data source, and click OK when you finish.
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6. Inthe Solution Explorer pane, you now see DefaultDataSource.rds in the Shared Data
Sources folder within the solution.

7. On the Microsoft Visual Studio toolbar, click File » Save All.

Save your solution often to prevent losing modifications in the event that BIDS terminates.

To select a Vision template and start to create a custom report, complete the following steps:

1. Inthe Solution Explorer pane, right-click the Reports folder, and from the shortcut menu, click
Add » New Item.

On the Add New dialog box, you see the Vision report templates.
2. Click a report template to open it and create a custom Vision report with it.

Specific instruction on how to create and design Vision custom reports is beyond the scope of this
document. For detailed information and training on how to design a Vision report with BIDS,
Deltek University offers report writing classes.

See http://www.deltek.com/services/deltekuniversity for class offerings.

Classes include instruction on how to replace special tags in SQL statements. The tags make it
possible to modify aspects of a query as it is passed from Vision to the Report Server. This
enables you to include a Sorting/Grouping tab or Columns tab on the report Options dialog box in
Vision Reporting for a custom report.

You can also contact CustomServices@Deltek.com for information about the custom report
services that Deltek provides.

3. After you create a custom report and it is ready for others to use, you must save the report .rdl file
to the appropriate folder on your Vision application server so it can be successfully loaded into
Vision. See the "Vision Application Server Location for Custom Reports" section on page 39 of
this guide for more information.

4. Deltek does not support the deployment of reports to the SSRS report server directly from within
the BIDS software. Instead, you use the Vision Report Administration utility to load custom
reports. See the "Load Custom Reports into Vision" section on page 41 for more information.

Multilingual Companies and Report Templates

You can create custom reports in multiple languages only if you purchase and activate the Vision
Multilingual module.

If you have multilingual companies in your enterprise and you want the ability to generate a report in
multiple languages from one report design, you must create custom reports with Vision report templates
loaded locally on a workstation. When you create a custom report with the Vision report templates directly
on your SSRS report server, the report can be generated only for the specific culture (language) from
which you accessed the report template.

Create a Custom Report from a Vision Standard Report in BIDS

If the content of a standard report is similar or close to what you need in a custom report, you may want to
start with a copy of a standard report .rdl file and then modify it in BIDS to suit your needs.

’ You cannot use Report Builder to create a custom report from a Vision standard report.
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Start with an .Rdl File that You Create from within Vision

One way to create a custom Vision report is to start with an .rdl file that you create when you preview a
standard report in Vision Reporting.

To create an .rdl file from a previewed standard report in Vision Reporting, complete the following

steps:
1.

From the Vision Navigation menu, click Reporting, and then click the menu item that contains the
standard report from which you want to create a custom report.

2. Onthe report form, click the cell in the Options column for the report that you want to start with,
and then click I;lthat displays in the cell.
3. On the report Options dialog box, select appropriate report options, and click Apply to return to

the report form.

On the report form toolbar, click ﬁ Preview.
On the toolbar of the report preview screen, double right-click the Find label to display the Get

Report Information [ “=]icon on the report preview toolbar.

) Project List

Monday, January 19, 2009
11:17:56 A

Project List

Apple & Bartlett, PC

Project Phase Task Hame Organization Name
noooont o General Overhesd Carporate

noooonq o ufali] Corporate Unassigned Corporate

0a00o0q oo 100 Boston Unassigned Boston Admin

0000001 .00 18R Boston Architectural Boston Architecture
noooon oo 1EM Bostan Endgineering Bosztan Endgineering
noooonq o 1 Boston Interiors Boston Engineering
0a00o0q oo 200 Zan Francisco Unassigned San Fran Admin
000001 .00 2AR San Francizco Architectural San Fran Architectural
noooon oo 2EM San Francisco Engineeting San Fran Engineering
0000001 .00 2EW San Francizco Environmental San Fran Environmenital

6. Click .

7. On the Report Information dialog box, select Report Definition (RDL File) from the drop-down
list in the View report information field, and then click View.

The Report Definition (RDL File) option provides you with the exact .rdl file that was used to

load the report instance as it was rendered on the report server. When you preview this .rdl file
within BIDS, it looks exactly like the one in the Vision Reporting preview window.

X

i ) Report Information

Wiew report information ‘eport Definition (ROL File)

Report Query

Report Options
Repart Definition (ROL File)

Wiy Close
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8. On the File Download dialog box, click Save or Open to save the .rdl file.

When you save the .rdl file for the new custom report (with either Open or Save), give it
the .rdl file name that you want it to have within a Bl project.

Do not give it the same .rdl file name as the Vision standard report that you created it
from.

The options on the File Download dialog box are:

= Open — This opens the .rdl file as XML code within BIDS; it does not open in BIDS as a
report within the designer. You can modify this file directly in the BIDS code view.

= Save — This saves the report as a new .rdl file. When you open this .rdl file in BIDS inside of
a Bl project, it displays exactly as it does in the Vision Reporting preview window.

= Cancel — This terminates the request.

i ) File Download g x|

Do wiou wank to open ar save this File?

File Mame: Woucher Ledger (Youcher Detail), rdl

| .......... D pen ......... :| | Save | | Caﬂce| |

At this point you are ready to modify the report within BIDS to create a custom report.
Open the Custom Report .Rdl File in BIDS

After you create and save a custom report .rdl file from a standard report, to open the custom
report .rdl in BIDS, complete the following steps:
1. Open a BI project within BIDS.
2. Choose the option to add an existing item to the project, and browse to where you saved the .rdl
file to open it.
Verify that the Data Source is Set for the Query

For custom reports that you created with a Vision standard report, you must verify that the data source is
set for the query.

To check the data source, complete the following steps:
1. With the custom report .rdl file open in BIDS, click the Data tab.

2. If you receive the following dialog box, it means that BIDS is not able to connect to a valid data

source for the selected dataset. You must fix the data source to point to the shared data source in
your Bl project.

If you do not receive the message, you are ready to modify the report
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Microsoft Report Designer

The data source DefaultDataSource was not Found,
&dd the data source ko the data set before proceeding or choose another data source.,

To fix the data source to point to the shared data source in your Bl project, complete the following
steps:

1. Inthe Microsoft Report Designer window that indicates that the data source was not found, click
OK.
2. On the Data tab, click the J button next to the dataset name to open the following Dataset
dialog box:
x|
Query |Fields I Data Options Parametersl Filkers I
Mame:
IRepnrtDataset
[rata source:
DefaultDatasource j |
DefaultDatasource

DefaultDataSource (shared)

Wisioni_ubes {shared)
Mew Daka Source,
=

SET TRAMSACTION ISOLATION LEVEL READ ﬂ S |
UNCOMMITTED; DECLARE @vbinContextInfo warbinary(128);3ET
@vhinCaontextInfo = COMYERT(varbinary(28), [*MN*/"' + replicatel" ',

14 - len( ¥+ 00 + COMYERT{varbinary(20), 'en-U3' + replicated’ ',

10 - len("en-1J3'));SET Context_info @vwbinConkextInfo;SELECTO ELI

Timeouk:

a4 I Cancel | Help J/

5

3. On the Dataset dialog box, from the drop-down list in the Data source field, select the data
source that is used within your Bl Project. This generally has “(shared)” within the name.

At this point you are ready to work on the design of the report.

XML Code that you Must Modify

When you start with a standard Vision report to create a custom report, you must modify some of the
XML code in the report's .rdl file to remove and replace items that are no longer appropriate for your
custom report. If you do not make these modifications, your custom report may not function properly. You

must make these modifications before you save a custom report to the application server and load it into
Vision.

Report Name

When you create a custom report from a Vision standard report, the custom report design contains the
name of the standard report that displays on the Vision Reporting menu.
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You must replace the standard report name with the custom report name on the Layout tab in BIDS.

Employee Labor _iLrdl [Besign]

%] Design | 2l Prevew

ﬂ"“ . «Exprs
S F F e Ve S IS RSPy, | FE T PR PP P e E TP PP NAPRRRRUEY, FOPSSUPRO PPN ———.. .. .
E
(Custom [LahelEmpluyeeLaburDetall] Ty
-Em:r:- - ".E'“"’ 1
[Lab-eubnrﬂod [L,ubel:labe] |LM:=PEde| |Lah=ﬂ=gl..-hrl’.‘ﬂ.[._ub-eﬂv1CH.LFH [Label0w12CALF [LabeTotalCRLF| [LabelTot
#CRLFUAE] LFHours] oura] Hours] OrviHrs)
«Exprs | | i [SumiRegHral]; [Sum{OviHre )] [Susn(ChviHra2 )] aExpra
[LoborCoge]  aExprs sExprs [RaegHrs] [CrviHrs] [CwiHrsd] sExprs
|Comment]
e J5UMIRegHIS)] Sum{Ovitirad)) SumiOvitira)) [Sumi Ovitira)] sum(Tou
aExpirs

If you do not replace the standard report name with a custom report name, both the standard
and custom report display on the Vision Reporting menu with the same report name.

Custom Properties

The XML section of a standard Vision report's .rdl file contains custom properties for reports that are used
to:

= Load the custom report using Vision's Report Administration utility.
= Control Vision report options.

You must delete and modify some of the existing custom properties that no longer apply for a custom
report. Your custom report will not function properly if you do not make these modifications.

Custom properties are defined between the <CustomProperties> and </CustomProperties> tags in the
XML code of a report's .rdl file. You modify custom properties in a report on the Properties window of the
report.

1. Inthe Properties list, navigate to CustomProperties.
2. Click the . ellipsis button to open the Custom Properties dialog box.

The following sections of this guide identify the custom properties that you must delete or modify.

ReportBO

The ReportBO custom property is used for Vision standard reports. It is not valid for custom reports and
must be deleted to prevent errors in Vision.

Delete the following section of the XML code (this example uses the standard Project List report):
<CustomProperty>
<Name>ReportBO</Name>
<Value>Deltek.Vision.ReportingProject.Server.ProjectList</Value>

</CustomProperty>
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ResourceFileName

When Vision loads the standard reports, the resource file is used to change report labels to the
appropriate culture. Because the custom report that you are working with already has its labels converted
to a specific culture, you must delete this ResourceFileName tag.

Delete the following from the XML code (this example uses the standard Project List report):
<CustomProperty>
<Name>ResourceFileName</Name>
<Value>Project List</Value>

</CustomProperty>

OptionForm

The OptionForm custom property controls the display of the report Options dialog box in Vision Reporting
for the custom report. If you want the report Options dialog box to display, you must replace the standard
report's OptionForm value with the following Vision default report value:

<Value>Deltek.Vision.Report.Client.VisionReportDialog</Value>
Example:
The original XML code in the standard Project List report:
<CustomProperty>
<Name>OptionForm</Name>
<Value>Deltek.Vision.ReportingProject.Client.dlgRepOpt_ProjectList</Value>

</CustomProperty>

Modified the XML code as follows:
<CustomProperty>
<Name>OptionForm</Name>
<Value>Deltek.Vision.Report.Client.VisionReportDialog</Value>

</CustomProperty>

in Vision Reporting will display a General tab, a Layout tab, and if you have added report

‘ For custom reports that are created with a standard Vision report, the report Options dialog box
parameters in Vision Custom Report Options Configuration, a Custom Options tab.

GroupingType

The GroupingType custom property controls whether or not the Sorting/Grouping tab displays on the
report Options dialog box in Vision Reporting. For custom reports that you create form a standard Vision
report, delete this custom property.

Delete the following from the original XML code (this example uses the Project List report):
<CustomProperty>
<Name>GroupingType</Name>

<Value>Project</Value>
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</CustomProperty>

To add a Sorting/Grouping tab to the report Options dialog box, you must modify special tags in
SQL statements. Instruction on how to do this is beyond the scope of this document. Report

writing classes offered through Deltek University cover special tags. See

http://www.deltek.com/services/deltekuniversity for class offerings.

UseColumnSelection

The UseColumnSelection custom property determines whether or not the Column tab displays on the
report Options dialog box in Vision Reporting. This tab allows you to select the columns for a report
before you generate it. For custom reports that you create form a standard Vision report, change the
UseColumnSelection value from Y to N.

Example:
The original XML code in the Project List report, where the value is setto Y:
<CustomProperty>
<Name>UseColumnSelection</Name>
<Value>Y</Value>

</CustomProperty>

Modify the original XML code as follows:
<CustomProperty>
<Name>UseColumnSelection</Name>
<Value>N</Value>

</CustomProperty>

statements. Instruction on how to do this is beyond the scope of this document. Report writing
classes offered through Deltek University cover special tags. See
http://www.deltek.com/services/deltekuniversity for class offerings.

‘ To add a Columns tab to the report Options dialog box, you must modify special tags in SQL

Further Instructions

Further specific instruction on how to create and design Vision custom reports is beyond the scope of this
document. For detailed information and training on how to design a Vision report with BIDS, check Deltek
University's report writing class offerings at http://www.deltek.com/services/deltekuniversity.

You can also contact CustomServices@Deltek.com for information about Deltek's assistance with custom
reports.

After you create a custom report and it is ready for others to use, you must copy the report .rdl file to the
appropriate folder on your Vision application server so it can be successfully loaded into SSRS and Vision
using Vision's Report Administration utility. See the "Vision Application Server Location for Custom
Reports" section on page 39 of this guide for more information.

Deltek does not support the deployment of reports to the SSRS report server directly from within the BIDS
software. Instead, you use the Vision Report Administration utility to load reports. See the "Load Custom
Reports into Vision" section on page 41 for more information.
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Custom Reports Created with Microsoft SQL Server
Reporting Services 2005

Overview

For Vision custom reports that were created with Microsoft SQL Server Reporting Services (SSRS) 2005,
you must use BIDS 2008 or Report Builder 2.0 to upgrade the reports to SSRS 2008 before you can use
them in Vision 7.0.

After you upgrade the reports, you must update report queries to revise any database table names that
have changed in Vision 7.0.

Other Vision 7.0 framework changes that are applied within the report business objects may affect your
custom reports after you upgrade, causing them to not work properly. If a custom report does not work
properly after you upgrade it to SSRS 2008 and update any renamed database tables, Deltek
recommends that you recreate the custom report using Vision 7.0 and BIDS 2008 or Report Designer 2.0.

Consider the following before you recreate a custom report with BIDS 2008 or Report Builder 2.0:
= Do you still need the custom report?
= Are there standard reports in Vision 7.0 that provide the information that you need?

= |s the custom report that you created with BIDS 2005 or Report Builder 1.0 based on a Vision
standard report? If so, you can start with a standard Vision report and modify it in BIDS 2008 or
Report Builder 2.0 to recreate your custom report.

If you need additional assistance with custom reports, contact the Deltek Consulting Services
Group at CustomServices@Deltek.com.

For detailed information and training on how to design a Vision report with BIDS or Report
Builder, Deltek University offers report writing classes.

For class offerings, see http://www.deltek.com/services/deltekuniversity.

Upgrade Custom Reports Using BIDS 2008

These instructions apply for Vision custom reports that you created with BIDS 2005. With these upgrade
instructions, you start by opening or creating a report project (instead of opening the report RDL files).

If Your Custom Reports Already Have a Report Project

To upgrade Vision custom reports to SSRS 2008 using BIDS 2008, complete the following steps:
1. Use BIDS 2008 to open an existing Vision custom report project.

2. Complete the wizard that starts automatically. It guides you through upgrading the report project
and all the reports contained in the project.

3. Open a custom report in BIDS 2008. For any Vision database tables included in the report that
have new names in Vision 7.0, replace the old names with the new names. The affected tables
and instructions are included in the “Vision 7.0 Database Table Name Changes that Affect
Custom Reports” section below.

4. Save the report.
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Repeat step 3 and 4 for each custom report in the report project.

Upload the custom reports to Vision using the Vision Report Administration utility as described in
the “Load Custom Reports into Vision” section. If a report does not run properly, you may need to
recreate it with BIDS 2008.

If Your Custom Reports Do Not Have a Reporting Project

In these instructions, you create a reporting project before you upgrade the reports.

To upgrade Vision custom reports to SSRS 2008 using BIDS 2008, complete the following steps:

1
2
3.
4

5.

Open Visual Studio 2008.
On the File menu, click New » Project.
In the Project types pane of the New Project dialog box, select Business Intelligence Projects.

In the Templates pane, select Report Server Project.

Mew Project 2lx|
B [ee
Project types: Templates: I.NEF Framewark 3.5 j -
Business Inteligence Projects Visual Studio installed templates
Visual C£
Other Languages __'?Analysis Services Project glmport Analysis Services Database
Other Project Types | Integration Services Connections P... ,_:-ﬂlnhegrah'nn Services Project
|- FlReport Server Project Wizard [ |Report Model Project

Report Server Project

My Templates

- 5earch Online Templates...

Create an empty Report Server project.

MName: I
Location: | j Browse... |
Solutiom Manie: | <Enter_name = [™ Create directory for solution

™ Add to Source Contral

(64 | Cancel |

In the Name field, enter a name for the report project. Enter a name that is related to the type of
reports you will add to this project. For example, for billing reports, you could name the project
“Billing.”

In the Location field, enter the location where the reports will be stored.

Deltek recommends that you store reports in <your Vision installation path>\Reports\Custom
Example: c:\\Program Files (x86)\Deltek\Vision\Reports\Custom

On the New Project dialog box, click OK.

Add the RDL file for existing custom reports to the report project:
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a) Inthe Solution Explorer pane, right-click the Reports folder, and select Add » Existing Item.

b) Inthe Add Existing Item dialog box, navigate to an existing RDL file to add it to the report
project.

c) Save the report file. When you save it, the schema of the RDL file is changed from SSRS
2005 to SSRS 2008.

d) Repeat these steps to add RDL files for other custom reports to the report project.

9. Open a custom report in BIDS 2008. For any Vision database tables included in the report that
have new names in Vision 7.0, replace the old names with the new names. The affected tables
and instructions are included in the “Vision 7.0 Database Table Name Changes that Affect
Custom Reports” section below.

10. Save the report.
11. Repeat step 9 and 10 for each custom report.

12. Upload the reports to Vision using the Vision Report Administration utility as described in the
“Load Custom Reports into Vision” section. If a report does not run properly, you may need to
recreate it with BIDS 2008.

Upgrade Custom Reports Using Report Builder 2.0
These instructions apply for Vision custom reports that you created with Report Builder 1.0.

With these instructions, you can update a report's RDL file directly.

To upgrade Vision custom reports to SSRS 2008 using Report Builder 2.0, complete the following
steps:

1. Use Report Builder 2.0 to open a custom report RDL file.

2. Save the report file. Saving it changes the schema of the RDL file from SSRS 2005 to SSRS
2008.

3. In Report Builder 2.0, for any Vision database tables included in the report that have new names
in Vision 7.0, replace the old names with the new names. These affected tables and instructions
are included in the “Vision 7.0 Database Table Name Changes that Affect Custom Reports”
section below.

4. Save the report.

Upload the report to Vision using the Vision Report Administration utility as described in the “Load
Custom Reports into Vision” section. If a report does not run properly, you may need to recreate it
with Report Builder 2.0.

Vision 7.0 Database Table Name Changes that Affect Custom Reports

Vision database tables used in reports that had a name change in Vision 7.0 are listed below. After you
upgrade your custom reports to SSRS 2008, you must replace the old table names with the new names in
report queries that include the affected tables. For example, if a custom report included the CFGCountry
table, you must replace CFGCountry with FW_CFGCountry. If you do not update the table names, you
will receive errors when you run the reports.
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Table Name in Vision 6.x Table Name in Vision 7.0
CFGCountry FW_CFGCountry
CFGCurrency FW_CFGCurrency
CFGPhoneFormat FW_CFGPhoneFormat
CFGEnabledCurrencies FW_CFGEnabledCurrencies
InfoCenterTabHeadings FW_InfoCenterTabHeadings
ReportPrinters FW_ReportPrinters
CFGCountry FW_CFGCountry

To change a table name in either BIDS or Report Builder, complete the following steps:
1. Open the report in either of the reporting tools.
2. Onthe Report Data pane, expand the Datasets folder.

3. Double-click ReportDataset.

Report Data

Mew + Edit... 3%

=13 Built-n Fields
G- Parameters

EHiT Datasets
j ReportDataset
H-2 SystemInformation

4. Inthe Query text box in the Dataset Properties window, find mention of the old table name, and
replace it with the new table name.

contents from the Query text box into a word processor. Then use Find in the word

’ To quickly determine whether the query contains an affected table, you can copy the
processor to search for the table name.
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Dataset Properhies .ﬂ

Choose a data source and create a query.

Parameters

Fields Name:
|P.eport|’.‘lataset

Options
Data source:

I DefaultDataSource j Hew... |

Query type:
* Tet ( Table ( Stored Procedure

Filters

Query:

BELECT a
AP AS Description, j i’

10.00 AS CurAmt,

20.00 AS YTDAmE,

30.00 as FutureBudd,

40.00 a3 FutureBudl, :]

Query Designer... | Import.. | Refresh Fields... |

Time out (in seconds):

|U' E.
Help 0K I Cancel

5. Click OK.

If you receive the following message, click OK in the dialog box. You do not need to refresh the
field list; you are updating the table name only.

Microsoft SQL Server Report Designer il

Could not update a list of fields for the query. Verify that you can
L& connect to the data source and that your query syntax is correct,
~ The shared data source 'DefaultDataSource’ does not exist or you

do not have sufficent permissions. For more information, contact
your report server administratar,

To continue without updating the fields list, dids Ok,
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Custom Reports Created with Actuate

Vision custom reports were created with Actuate prior to Vision 6.0. There is no automated process to
convert custom Vision reports that were created with Actuate to SSRS reports.

If you have custom Vision reports that were created with Actuate, consider the following before you
recreate the custom report with Report Builder or BIDS:

= Do you still need the custom report?
=  Are there standard reports in Vision 7.0 that provide the information that you need?

= Is the custom report that you created with Actuate based on a Vision standard report? If so, you
can start with a standard Vision report and modify it in BIDS.

For detailed information and training on how to design a Vision report with Report Builder or BIDS, Deltek
University offers report writing classes.

See http://www.deltek.com/services/deltekuniversity for class offerings.

The Deltek Custom Development Group provides custom report services. You can contact them at
CustomServices@Deltek.com for information about the assistance that they provide.
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Implementing Custom Labels in Custom Reports

You can implement custom labels in custom reports by using a custom resource file (a .resx file) rather
than by modifying the Deltek.Vision.ReportLabels.Server.dll file. As a result, when Deltek makes a
change to a standard label in Vision, it has no effect on your custom labels in custom reports.

The standard resource file for a report, lookup, or report group is used by default to replace labels.
However, if you create a custom resource file, the resource labels in that custom file override the
corresponding standard labels. The custom resource files only need to contain the custom labels; Vision
uses the standard labels in all other cases.

Non-Multilingual Companies

If you do not use the Vision Multilingual module, Vision looks for custom resource files in this location:
<Installation location>\Reports\Custom\Resource Files\en-US.

Example: C:\Program Files\Deltek\Vision\Reports\Custom\Resource Files\en-US.
The resource file name formats are the following:
= Report labels: Custom_<ResourceFileName custom property from the RDL file>.en-US.resx
= Report group labels: Custom_ReportGroup_<group id>.en-US.resx
= Lookup labels: Custom_Lookup_<lookup id>.en-US.resx
Examples:
= Custom_Contact List.en-US.resx
= Custom_Lookup_Employee.en-US.resx

= Custom_EmployeeList.en-US.resx

Multilingual Companies

If you use the Vision Multilingual module, Vision looks for custom resource files in this location:
<Installation location>\Reports\Custom\Resource Files\<culture>.

Example: C:\Program Files\Deltek\Vision\Reports\Custom\Resource Files\en-GB.
Cultures are:
= en-US — United States English
= en-GB — International English
The resource file name formats are the following:
= Report labels: Custom_<ResourceFileName custom property from the RDL file>.<culture>.resx
= Report group labels: Custom_ReportGroup_<group id>.<culture>.resx
= Lookup labels: Custom_Lookup_<lookup id>.<culture>.resx
Examples:
= Custom_Contact List.en-GB.resx
= Custom_Lookup_Employee.en-US.resx

= Custom_EmployeeList.en-GB.resx
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Vision Report Server Location for Custom Reports

To load custom reports into SSRS and Vision, you must save custom report .rdl files on the Vision report
server in the following location:

C:\Program Files\Deltek\Vision\Reports\Custom\My Reports

Within the My Reports folder, create subfolders with the following names, and save the .rdl files in the
appropriate subfolders:

= Accounting

= AccountsReceivable
= Billing

= Client

= Consolidated GL

= Contact

= DataExport

=  Employee

= GeneralLedger

= Inventory

= Invoice

= Lead

=  MarketingCampaign
= Opportunity

= Payroll

= PerformanceManagement
= Project

= Purchasing

= ResourcePlanning

= TextLibrary

= Unit

= Vendor

You must save a custom report in the appropriately named subfolder so that the custom report displays
with other Vision standard reports on the corresponding Reporting submenu in Vision. For example, if you
create a custom report that has employee data, you can save the report on your Vision report server in:

C:\Program Files\Deltek\Vision\Reports\Custom\My Reports\Employee

After you load the report in Vision, it displays in Reporting » Employee.

from within the BIDS or Report Designer software. When a custom report is ready to distribute to
other Vision users, you copy the report to your Vision report server and load the report into
SSRS and the Vision Reporting menu with the Vision's Report Administration utility.

Deltek does not support the deployment of reports into SSRS or the Vision report server directly
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Load Custom Reports into Vision

After you create a Vision custom report and save the .rdl file to the correct location on your Vision
application server, a system administrator uses the Vision Report Administration utility to copy the report
into SSRS and make it available in Vision Reporting.

When you run the Report Administration utility to load custom reports, Vision users cannot
access any reports.

To load custom reports into SSRS and Vision, complete the following steps:
1. From the Vision Navigation menu, click Utility » Report Administration.

2. Onthe Load Reports tab, the Location of reports on application server field displays the path
to the Vision application server location—C:\Program Files\Deltek\Vision\Reports.

3. From the drop-down list in the Report Type field, select Custom.

|" <« Report Server: CAMQARPTLUNA (Root Folder: VisionEuropa)

( .Hél.[:l. -

Load Reports | Report Printers | Currenk Activity| Report Logging | Database Cleanup

Location of Reports on Application Server | C:AProgram FilesiDelkekiVision\Reports |
Type | Cuskam = | Report Marme | My CustomRepoart |
] Delete Existing Reparts in Each Faolder Before Loading | Load Report Files | | Check Report Wersion |

Loaded Reports ~

[

Repart Path | Lookup Type 48 Group Type -l:l Version 4| I
)]jstandard,u'.ﬁ.ccountmglfcashFlowForecast oAbl bl | et I B EIE i A [? P ]
| J5tandard/Accounting/Cash Journal | | | 7.0.0.416 | |T

Ready

4. Inthe Report Name field, enter the name of the custom report that you want to load into Vision—
without the .rdl file extension.

If you leave the Report Name field blank, all custom reports are deployed and loaded.

5. If you select the Delete existing reports in each folder before loading check box, Vision
deletes all reports of the type that you selected that are currently loaded, and then it loads the
reports from the application server Reports folder.

6. Click the Load Report Files button.

7. Click Yes on the dialog box that warns you that loading reports prevents users from running
reports for a few minutes.

Jti/' WARNING : Loading reports anto FTCL-BHALL will prevent ALL users from running reports on this server For a Few minutes. Are you sure you want ko

do this?
I s I o
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8. On the dialog box that informs you that reports have been loaded, click OK.

J 4) 1 Reports loaded (including sub reports)

ok,

The custom report now displays on a submenu of the Vision Reporting menu. The submenu is
determined by the folder in which you saved the custom report on your application server. See
the "Vision Application Server Location for Custom Reports" section on page 39 of this guide.

The custom report also displays in the Report Name drop-down list in Configuration »
General » Custom Report Options where you can add parameters to it.
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Parameters in Custom Reports

Parameters that you add to a report allow users to filter the report content before they generate the
report. For example, you could add a parameter to a report that allows you to enter a period start and end
date so that you can include data for only certain periods on the report.

Parameters that you add to a custom report design in the .rdl file, display as options on the Custom
Options tab of the report's Options dialog box in Vision Reporting if you complete both of the following:

= In the custom report .rdl file, you must add the prefix "cust” to the parameter name so that it will
work with Vision.

The following example shows two parameters with the names custPeriodStartDate and
custPeriodEndDate within the XML code of an .rdl file in BIDS.

- zReportCptionParameters=
zMamezxcustPeriodStartDate</MName:
<Walue=2005-12-05T00:00:00.000=/% alue=
=Label=Report Period Start Date</Label=
=Type=DateTime</Type=

</ReportOptionParameters>

- =ReportOptionParameters
zMamezxcustPeriodEndDate</MName=
<Walue=2008-12-27T00:00:00.000=/% alue=
<Label=Report Period End Date=/Labeal>
=Type=DateTime</Type>

</ReportOptionParameters

= After you deploy and load the custom report into Vision with Vision's Report Administration utility,
you add the report parameters to the report in Vision Configuration » General » Custom Report
Options.
To add the parameters in Vision, complete the following steps:
1. From the Vision Navigation menu, click Configuration » General » Custom Report Options.

2. Onthe Report Custom Options form, select the custom report from the Report Name drop-down
list.

A Report Custom Options

Project/dltkProjectList custom report options

Report Name

Options -

ProjectfVouchers by Project
§ Display
Purchasing/Blanket Purchase Orders Width
| Purchasing)Ttem By Consultant/Partner ;
Purchasing/Open Purchase Orders
Purchasing/Purchase Order Cost Distribution Detail
Purchasing/Purchase Order Detai -

Option
Label

3. On the Options grid toolbar, click Insert to add a parameter to a blank row in the grid.
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4. Inthe Option Label field, enter the text that you want to display for the parameter on the Custom

Options tab on the Report Options dialog box in Vision Reporting.

5. Inthe Parameter Name field, enter the name of the parameter as it is entered in the custom

report .rdl file but without the prefix "cust."

6. Inthe Data Type field drop-down list, select the type that matches the data that the parameter

contains.

Options ~ 45 Insert X Delete %, Rearder

Opkion Parameter Data
Label Mame Type

Default
Walue

Report Perind Start Date | PerindStartDate Date

b

Report Period End Date | PeriodEndDate Date

Account
Character
CheckBox
Company
Consultant/Par
Conkact

Employes :

7. Complete the remaining fields in the grid as appropriate for your parameter data type.

8. When you finish, click ESave.

To use the parameters before you generate a custom report:

1. On the Vision Reporting menu, navigate to the custom report location.

2. Onthe Report form, click the cell of the custom report's Options column to display and click the

|;| icon.

» Vendor Reporting
 Print dule B Email B C

Reports | Archived Reports | Current Ackivity |
Repaorts - /\ f= Organize Favorites 4 Refresh
Fepart Mame ( COptions ) Selection Favarite Folder <

Cash Requirements \ / O Skandard
Cash Requirements Bank Summary O Skandard
CRM Yendor Summary O Standard
vendar Audit O Standard
Yendor Audit Detail O Standard
Wendor List O Standard
Wendor Mailing Label O Skandard
Wendor Summary O Standard
Woucher Ledger / \ O Skandard

b | Youcher Schedule ‘ . ) O Standard

\—/ ¥
[] show Favarites Only
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3. On the report Options dialog box, click the Custom Options tab to enter parameter options before
you print or preview the report.

¥ ) ssps Training Project List Options zl
General | Layout | Custom Oplions |
Report Period Start Date) | =]
e O [I‘.El
Options | |~ Ogunze || Defait |[ Hep [ apply || Cancel |

Custom Reports and Microsoft SQL Server® Reporting

Services 45



y

Apply Role Security to Custom Reports

Deltek kwumore.

Apply Role Security to Custom Reports

After a custom report is created and loaded into the Vision software, a Vision system administrator

applies Vision role security to allow only the appropriate users to have access to the custom report on the

Vision Reporting menu.

To add a custom report to the list of reports that a role can access, complete the following steps:
1. From the Vision Navigation menu, click Configuration » Security » Roles » Access Rights tab.

2. From the drop-down list in the Functional Area field, select Reports.

| X Roles il N <)
ACCOUNTING
General |Record Arcess | Accounting | Flannirg | Access Rights | Document Management
-
Functional Area | Reparts |§ Full access to all reparts [ Set GroupfColurmn Access | =
Report Type | Accounting | v| Custom Type | Standard | v|
Available Reports | Reports For this Role |

Cash Flow Forecast
Cash Flows Statermnent
Cash Journal

Cash Receipts

Chart of Accounts Audit Add-=
Chart of Accounts Audit Detail ml
Check Register

GainsfLosses and Revaluations Detail
Intercompany Billing

Labor Cross Charge

Overhead Allocation

ReviEenlLog

Sales List 1)

Tax Analysis

[

3. From the Report Type field drop-down list, select the type of the report (Accounting, Accounts
Receivable, and so on) for which you want to give access.

4. Select Custom from the Custom Type field drop-down list.
The custom reports for the report type display in the Available Reports pane of the tab.

6. Click the appropriate custom report in the Available Reports pane, and click the Add button to
add it to the Reports for this Role pane.

7. When you finish, click ESave.
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Get Report Information for Failed Reports

You use the Get Report Information icon on a previewed Vision standard report to create an .rdl file with
which to create a custom report. You can also use this tool to obtain information about custom reports in

general or acquire information about a report if the report fails in Vision.

If areport fails when you preview it in Vision, complete the following steps:

1. On the toolbar of the report preview screen, double right-click the Find label to display the Get

Report Information [ ==]icon.

-f:'f_:l Project Progress

Project Progress

1 of 1 & & O 4 0@ | 10

Monday, January 19, 2009
11:38:53 AM

Apple & Bartlett, PC Far the period 2M 2005 - 202872005
Current  Current JTD JTD Budget Budget % % Balance Balance
Hours Billing Hours Billing Hours Billing Exp Rpt Hours Billing

2. Click , and on the Report Information dialog box, select any of the options that you need to
produce the report query, the report options (XML String), and the report .rdl file (and also an

XML file), and then click View.

(¥ ) Report Information : ﬂ

Yigw report information

Lepark QJery

Report Query

Report Options
Report Definition (ROL File)
| view || Close

The options in the drop-down list accomplish the following:

= Report Query — This returns the query that was executed by the report. Because the query
is returned in XML format, it can be copied and pasted directly into Microsoft SQL Server
Management Studio Query window or onto the BIDS Data Tab where it can be executed.
Since the BIDS Data Tab and Microsoft SQL Server Management Studio doe not execute
XML SQL directly, you need to make a few edits. It does not matter if you edit the query in

your favorite XML editor or save it to a file.

In either case, you will see something that resembles the following when you view the query

information:

<Query><!/[CDATA[SET TRANSACTION ISOLATION LEVEL READ UNCOMMITTED ...

II></Query>
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To run this query within Microsoft SQL Server Management Studio, you must modify the XML
to resemble the following:

SET TRANSACTION ISOLATION LEVEL READ UNCOMMITTED
After you complete this modification, the query will execute without issue.

Report Options — This returns the options that were selected on the Vision report Options

dialog box when the report was rendered. The options are returned in XML format. This XML
cannot be placed within the RDL Code.

Report Definition (RDLFile) — This provides you with the exact .rdl file that was used to
load the report instance as it was rendered on the SSRS report server. When you preview
this .rdl file within BIDS, it looks exactly like the one in the Vision Reporting preview window.
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Contents of the Vision Report Model

The Vision custom report model—DeltekVisionReportModel.smdl—contains data sources and Vision
database fields that allow you to create accounting, project, and customer relationship management
reports with SSRS's Report Builder.

Field Icons

In Report Builder, you access the Vision report model and choose an entity from which to create a report.
In the following example, the General Ledger entity is highlighted in the Entities section. The fields
available in the General Ledger entity display in the Fields section below it.

_‘% Reportl - Microsoft Report Builder
File  Edit Wiew  Insert  Format  Rep

A Iﬁ H ) X |§||gDesign Repnrt|

Explorer *

DeltekyisionReportModel

£
il

Entities:

Accounts Pavable
Accounts Receivable
Client

Zonkack

Employee List
Employee Include Labor
General Ledger

Lead

Marketing Campaign
Opportunity

Payroll

Project Expense -

| v

Entities within
the Vision report
model

A O A

i O O r O

Eﬁi

Fields:

]' #General Ledger Daka Sources
Pkew
Accounk
Account Code
Accounk Descripkion
Detail Account
Transaction Type
Transackion SubType
Bank Code
TransTwpePostControl

| »

Fields within the
entity that you
selected above

BB R B R R B OH R RS

Auko Entry
} Total Periad
} Total Posting Sequence

General Ledger Entity and Field List
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The field list for an entity displays an icon beside each field to indicate the type of field—text, number,
date/time, or aggregate—as in the following example.

Fields: ==
} #General Ledger Data Sources (B8
a Py
d Account

# Account Code

A Account Descripkion

Detail Account

Transaction Type

Transackion SubType

Bank Code

TransTypePostConkrol
a Auko Enkry

1 Total Periad

} Taokal Pasting Sequence

BB R R R

d Reference Mumber
£H] Transaction Date

4 Description 1

a Description 2

Field Icon Examples

The field type icons are as follows:

Field Icon Type of Field Description

a Text The field contains text.

# Number The field contains a numeric value.

it Date/Time The field contains a date, time, or both.

Aggregate The field contains a numeric value that represents a

calculation on a set of numbers.

Not applicable This displays beside an aggregate or date/time field. Click
to display additional options for a field.

= Not applicable This displays beside an aggregate or date/time field that you
expanded. Click =lto close the list of additional options.
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[ H#<Vision Entity Name>

In Report Builder, the first item in the Field list for Vision entities is the entity name with a # symbol in
front of it. For example, #Project Expense Data Sources displays as the first item for the Vision Project
Expense entity.

Iiﬁ:

Figlds:

} #Project Expense Data Sources o

Projeck
Phase
Task

Entity name is
preceded with a
# symbol

a

a

a

a Project Marne
a Phase Mame
4

Task Mame

When you add this field to a report, it counts the items that are used to compile the information in a row
on the report.

For example, you create a project expense report with the following columns:

Project Expense Vendor #Project Expense Data Sources
ABC FedEx $500 $2,000 27
ABC Knecht's Survey $7,000 $15,000 9

The FedEx cost and bill amounts of $500 and $2,000 are the sum of 27 transactions. The Knecht's
Survey amounts are the sum of 9 transactions.

Aggregate Numeric Fields

In Report Builder, many fields that contain a numeric value have an Additional Options icon and an

Aggregate icon beside them. When you click , additional options display as in the following
example for Total Expense Cost Amount.

Fields: o Fields: =
} Total Expense Period ;I } Total Expense Period ﬂ
i Expense TransDate £ Expense TransDate

d Expense Reffo a Expense RefMo
a Expense Descl a4 Expense Descl
d Fypense Descs a Fynense Decr?
L Total Expense Cost Amounk = -} Total Expense Cost Amaount
} Tokal Expense Bill Amaount #* Expense coskamaunt
a Expense Invoice } Avg Expense Cost Amounk
} Total Expense Line } Min Expense Cost Amount
a Expense VendOrg
} Tokal Expense Post Seq } Total Expense Bill Amount
a Expense xferwBsl 4 Expense Invoice

Total Expense Cost Amount Example
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Each of these numeric options produce the following content when added to a report:

Total Expense Cost Amount — This returns the total expense cost amount for all the transactions
that make up the expense cost.

# Expense costAmount — This returns the number of transactions (count) used to make up the
total expense cost amount.

Avg Expense Cost Amount — This returns the average value of all the transactions that make up
the total expense cost amount.

Min Expense Cost Amount — This returns the minimum value of all the transactions that make up
the total expense cost amount.

Max Expense Cost Amount — This returns the maximum value of all the transactions that make
up the total expense cost amount.

Date/Time Fields

Fields that contain a date, time, or both have a Calendar [ icon beside them in the Fields list in Report

Builder.

When you click , beside the Calendar icon, additional options display, as in the following example of

the Expense TransDate

Fields:

Fields:

A Expense TransTvpe
a Expense TransFer
a ExpenseType

d Expense SubTvpe

[- FE] Fxpense Transhate

a Expense Refflo
a4 Expense Descl
A Expense Desc?
} Total Expense Cost Amaunt
} Total Expense Eill Amount
4 Expense Invoice

=4
:l a4 Expense TransType
a4 Expense Transfer
A ExpenseType
d Expense SubTvpe
ok s = i
E [ Expense TransDate
# Expense Trans Day
# Expense Trans Monkh

N\

# Expense Trans Year
#* Expense Trans Quarker
]' First Expense Trans Dake

\‘ } Lask Expense Trans Date]

Expense TransDate Example

=

Using the Expense TransDate example, each calendar option produces the following content when added
to a report. In this example, the transaction date is August 21, 2009, which is a Friday.

= Expense TransDate — Returns the full date (08/21/2009).
= Expense Trans Day — Returns only the day of the date (Friday).

= Expense Trans Month — Returns only the month of the date (August).

= Expense Trans Year — Returns only the year of the date (2009).

= Expense Trans Quarter — Returns the quarter of the date (3).

= First Expense Trans Date — Returns the first (earliest) date of all the transactions that are
included on the report. This is more commonly included in a report header.
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= Last Expense Trans Date — Returns the last (latest) date of all the transactions that are
included on the report. This is more commonly included in a report header.

The following sections describe the Vision report model entities and their fields.

example, when you create a report with the Project entity, you cannot include fields from the

’ When you create a report, you can include only the fields from one entity on a report. For
Accounts Payable entity to the report.

Accounts Payable Entity

Use the Accounts Payable entity to create custom Vision Accounts Payable reports. When you use this
entity, report content is retrieved directly from or calculated with fields from the following Vision tables:

= VE (Vendor)
= VO (Voucher)
= LedgerAP (Expense Detail Table — Accounts Payable)

The Accounts Payable entity provides you with the following fields to add to custom reports:

Accounts Payable Field Description

#Accounts Payable Data When you add this field to a report, it counts the items that
Sources were used to compile the information in a row on the report.
Check Bank Code The bank code to which vouchers were posted during

transaction posting.

Check Date The date of the transaction.

Check RefNo The check number that is associated with this payment. This
column is used for void check transactions.

Description The descriptive text for the line item that explains the reason
for the expense, such as "travel advance" or "phone bill."

Invoice Date The date entered during either invoice or cash receipt
transaction entry.

Invoice Number The billed invoice number of the transaction.
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Accounts Payable Field Description

PWPCode

The status of each Pay When Paid (PWP) voucher:

= NF — Not found. Indicates that you entered or
posted the voucher and the voucher was included on
a final bill for the project. This status also displays for
all vouchers not marked as PWP.

= NP — Not paid. Indicates that you accepted the final
invoice and posted the resulting invoice file (that
contains the pay when paid voucher).

= PD — Paid. Indicates that you posted the cash
receipt (indicating to Vision that the client paid the
bill) for the invoice that contained the voucher. The
voucher is available for payment processing.

Total Voucher Amount

The total amount of the voucher before payments and
discounts are applied.

Total Voucher Balance

The balance owed to the vendor for all vouchers.

Total Voucher Discount

The amount of the discount taken to date if discounts were
applied to this voucher.

Total Voucher Previous
Payments

All the previous payments made on the voucher.

Vendor

The vendor identifier. The vendor number may be up to 20
characters, including two user-defined delimiters.

Vendor Name

The vendor's name entered in the Vendor Info Center.

Vendor Org

The vendor's organization. Used for sorting purposes only.

This is the name of the organization within your company for
which this vendor provides goods or services.

Vendor Pay Terms

The payment terms — Next, Hold, PWP (Pay When Paid),
Partial, or Date.

Vendor SortName

A combination of the vendor number and name.

Vendor Status

The vendor's status — A-Active, I-Inactive, or D-Dormant.

Vendor Type

The vendor type such as Trade, Consultant, or Employee.

Voucher

The voucher number assigned during transaction posting.
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Accounts Payable Field Description

Voucher Account

The account number for the Vision account that is associated
with this voucher. It is specified during Transaction Entry. If
the related project is a regular project, this is either a
reimbursable or direct account. If the related project is an
overhead project, this is an indirect account.

Voucher Bank Code

The code for the bank involved in the transaction.

Voucher BilledInvoice

The invoice on which the transaction was final billed.

Voucher BilledWBS1

The project to which the transaction was final billed on the
invoice.

Voucher BilledWBS2

The phase to which the transaction was final billed on the
invoice.

Voucher BilledWBS3

The task to which the transaction was final billed on the
invoice.

Voucher Date

The date of the voucher.

Voucher Desc2

Descriptive text for the line item to explain the reason for the
expense (such as "travel advance," "phone bill," and so on).

Voucher LiabCode

The accounts payable liability code to which this voucher was
posted.

The liability code identifies the account that receives the
implicit posting during Accounts Payable Voucher Posting;
the liability code defines the credit posting in the General
Ledger.

If your firm uses the Organization application and you
maintain separate balance sheets by organization, the liability
code also points to an organization code.

Voucher Line

The line number for each item listed on the voucher.

Voucher Payment Date

The payment due date if the Pay Terms setting is Date.

Voucher SubType

A one-letter code that represents the transaction's sub-type
(for example, A for automatic check, C for disbursement
check, or V for voided check). See Transaction Types in the
Accounting Concepts help for a full listing.

Voucher TransType

A two-letter code that represents the type of transaction (for
example, PP for Accounts Payable payment processing). See
Transaction Types in the Accounting Concepts help for a full
listing.
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Accounts Payable Field Description

Voucher WBS1 The project associated with the voucher that is specified
during transaction entry.

Voucher WBS2 The phase associated with the voucher that is specified
during transaction entry.

Voucher WBS3 The task associated with the voucher that is specified during
transaction entry.

Accounts Receivable Entity

Use the Accounts Receivable entity to create custom Vision Accounts Receivable reports. When you use
this entity, report content is retrieved directly from or calculated with fields from the following Vision
database tables:

= LedgerAR (Expense Detail Table — Accounts Receivable

= CFGARMap (Configuration Table — Accounts Receivable Mapping)
= PR (Project)

= AR (Invoice Master)

= CL (Client)

= BTBGSubs (Billing Terms Billing Group Subprojects)

= CFGInvMap (Configuration Table - Invoice Mapping Accounts)

= EM (Employee)

The Accounts Receivable entity provides you with the following fields to add to custom reports:

Accounts Receivable Field Description

#Accounts Receivable Data | When you add this field to a report, it counts the items that

Sources were used to compile the information in a row on the report.

Account The accounts receivable account to be mapped to the
Accounts Receivable Ledger columns.

BillCIAddress The client's billing address.

BillClientID The record number for the billing client.

BillContactID The record number for the billing contact.

ClAddress The client address.

ClientID The number of the client that is associated with the
transaction.

CRComment The full text of the cash receipt comment.
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Accounts Receivable Field Description

InvComment

The full text of the invoice comment.

Invoice Description

If Receipt displays in the Invoice column, Vision displays the
reference number entered during Cash Receipt Transaction
Entry. This column may also display the invoice number, the
year and month, and the number of postings for the
accounting period against which the report is being run.

InvoiceNumber

The invoice number that is associated with the transaction at
the time of posting or the final invoice number assigned to the
invoice during a final billing session.

RecDate The date on which the cash receipt was issued.

RecType The transaction type for the cash receipt expense detail. See
Transaction Types in the Vision Accounting Concepts help for
a full listing.

RefNo The reference number that is associated with the transaction

during transaction entry.

Total Age 1 Amount-Total
Age 5 Amount

Fields that represent additional aging ranges on invoices. By
default, Vision has the following aging columns:

Age Invoice Falls in the period:

0 to 30 days

31to 60 days

61 to 90 days

91 to 120 days

121 days and older

a b WODN PP

Total Col 1 —Tot Col 8

The Accounts Receivable mapped amounts in Configuration
» Accounts Receivable.

Total Period

The fiscal year and period for the expense detail.

Total Post Seq

The unique number assigned to the transaction during
posting.

Total Rtn Amt

The retainage amount of the invoice not currently due.
Retainage is an amount that you withhold from billing a client,
as a good faith measure to build trust in your firm, or to entice
the client to hire your firm.
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Accounts Receivable Field Description

Total Total Amt The total amount of the invoice and the total amount of each
receipt for that invoice. The total is then distributed across the
appropriate user-defined columns (customCol1-
customcol15), such as the Fees, Reimb., Taxes, Interest,
and Other columns. The total of these user-defined columns
should equal the amount in the Total column (TotalAmt).

TransDate The date of the transaction.

WBS1 The project number associated with the transaction.

WBS1Name The project name associated with the transaction.

WBS2 The phase number associated with the transaction.

WBS2Name The phase name associated with the transaction.

WBS3 The task number associated with the transaction.

WBS3Name The task name associated with the transaction.

Client Entity

Use the Client entity to create client reports. When you use this entity, report content is retrieved from or

calculated with fields from the following Vision database tables:

= CL (Client)

= CFGClientStatus (Configuration Table — Client Status)
= ClAddress (Client Address)
= CFGClientType (Configuration Table — Client Types)

=  CFGCountry (Configuration Table — Countries)
= ClientCustomTabFields (Clients Table — User-Defined Tab Fields)

The Client entity provides you with the following fields to add to custom reports:

Client Field Description

#Client Data Sources

When you add this field to a report, it counts the items that
were used to compile the information in a row on the report.

Billing Address Description

The description that is entered in the Client Info Center to
identify the client's billing address, such as Company
Headquarters, Main Office, Billing Office, and so on.

Billing Address1-Billing
Address4

The client's billing address information from Address 1 —
Address 4 lines in the Client Info Center.
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Billing City

The city from the client's billing address.

Billing Country

The country from the client's billing address.

Billing Create Date

The date on which the billing address was created in the
client record.

Billing Create User

The user ID of the person who created the billing address in
the client record.

Billing Fax

The fax number of the billing client contact.

Billing Mod Date

The date on which the billing address was most recently
modified in the client record.

Billing Mod User

The user ID of the last person who modified the billing
address in the client record.

Billing Phone

The phone number of the billing client contact.

Billing State

The state from the client's billing address.

Billing Tax Country

The tax country code from the client's billing address.

Billing Tax Registration
Number

The tax registration number from the client's billing address.

Billing Zip

The ZIP code from the client's billing address.

Client Name

The name of the firm (client) for whom you are performing
work.

Client Number

The client identifier.

Create Date

The date on which the client record was created.

Create User

The user who created the client record.

Mod Date The date on which the client record was last modified.

Mod User The user ID of the person who most recently modified the
client record.

Notes The text that is entered in the Notes field on the General tab

of the Client Info Center.

Primary Address Create
Date

The date on which the primary address was created in the
client record.
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Client Field Description

Primary Address Create
User

The user ID of the person who created the primary address in
the client record.

Primary Address
Description

The description entered in the Client Info Center record to
identify the client's primary address, such as Company
Headquarters, Main Office, Northeast Office, and so on.

Primary Address Mod Date

The date on which the primary address was most recently
modified in the client record.

Primary Address Mod User

The user ID of the last person who modified the primary
address in the client record.

Primary Addressl1-Primary
Address4

The client's primary address information from Address 1 —
Address 4 lines in the Client Info Center.

Primary City

The city in which the client's primary address is located.

Primary Country

The country in which the client's primary address is located.

Primary Fax

The fax in which the client's primary address is located.

Primary Phone

The phone in which the client's primary address is located.

Primary State

The state in which the client's primary address is located.

Primary Tax Registration
Number

The tax registration number for the client's primary address.

Primary TaxCountry

The tax country code for the client's primary address.

Primary Zip

The ZIP code in which the client's primary address is located.

Relationship

Your relationship with the client, such as Consultant,
Prospective, Existing.

Status The status of your relationship with the client (Active,
Dormant, or Inactive).

Type The type of client such as Commercial, Government, Non-
Profit, and so on.

Website The client firm's Internet Web site address.
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Contact Entity

Use the Contact entity to create contact reports. When you use this entity, report content is retrieved from
or calculated with fields from the following Vision database tables:

= Contacts
= CL (Client)
= VE (Vendor)

The Contact entity provides you with the following fields to add to custom reports:

Contact Field Description

#Contact Data Sources When you add this field to a report, it counts the items that
were used to compile the information in a row on the report.

Active Company If you use the Multicompany feature in Vision, this is the
company that you have open when you run a report.

Address1-Address4 Lines 1-4 of the contact's address.

Cell Phone The contact's cellular phone number that is entered on the
General tab in the Contact Info Center.

City The contact's city.

Client Address1-Client The client's address information (street name and number,
Address4 suite number, and P.O. Box number) if the contact is a client.
Client City The client's city if the contact is a client.

Client Country The client's country if the contact is a client.

Client Fax The client's fax number if the contact is a client.

Client ID The internal reference number for the Client record.

Client Memo The contents of the Notes field in the Clients Info Center if

the contact is a client.

Client Name The client firm's name if the contact is a client.

Client Phone The client's telephone number if the contact is a client.

Client Relationship Your relationship (New, Existing, or Prospective) with the
client.

Client State The client's state if the contact is a client.

Client Status The client's status (A-Active, I-Inactive, or D-Dormant) that is

entered on the General tab in the Client Info Center if the
contact is a client.
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Contact Field Description

Client Website

The client's Web Site address that is entered on the General
tab in the Client Info Center if the contact is a client.

Client Zip

The client's ZIP code if the contact is a client.

Concat Client Address

The client's address, city, state, and ZIP code (in this order in
a single column on the report) if the contact is a client.

Concat Vendor Address

The vendor's address, city, state, and ZIP code (in this order
in a single column on the report) if the contact is a vendor.

Concatenated Address

The contact's address, city, state, and ZIP code (listed in this
order in a single column on the report).

Contact ID

Internal reference number for the contact record.

Contacts Notes

The contents of the Notes field on the General tab in the
Contacts Info Center for the contact.

Country

The contact's country.

Create Date

The date on which the contact record was created.

Create User

The user who created the contact record.

Email The contact's email address that is entered on the General
tab in the Contact Info Center.

Fax The contact's fax number that is entered on the General tab
in the Contact Info Center.

First Name The contact's first name that is entered on the General tab in
the Contact Info Center.

Full Name The contact's full name (first, middle, and last names), which

is entered on the General tab in the Contact Info Center.

Home Phone

The contact's home phone number that is entered on the
General tab in the Contact Info Center.

Last Name

The contact's last name that is entered on the General tab in
the Contact Info Center.

Mailing Address

A 'Y or N (Yes or No) value that indicates whether or not the
address is the contact's mailing address.

Mailing Address1-Mailing
Address4

Address lines 1-4 from the contact's mailing address. The
mailing address is entered on the General tab in the Contact
Info Center.
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Contact Field Description

Mailing City

The city from the contact's mailing address.

Mailing Country

The country from the contact's mailing address.

Mailing State The state from the contact's mailing address.

Mailing Zip The ZIP code from the contact's mailing address.

Middle Name The contact's middle name from the General tab in the
Contact Info Center.

Mod Date The date on which the contact record was most recently
modified.

Mod User The user who last modified the contact record.

Pager The contact's pager number from the General tab in the
Contact Info Center.

Phone The contact's telephone number from the General tab in the

Contact Info Center.

Preferred Name

The contact's preferred name from the General tab in the
Contact Info Center.

Salutation The prefix, such as Mr. or Ms., used with the contact's name.

Source The source that is entered in the lead's Info Center record
when the contact is a converted lead.

State The contact's state.

Status The status of your relationship (Active or Inactive) with the
contact, as entered on the General tab in the Contact Info
Center.

Suffix The suffix, such as Jr. or lll, used with the contact's name.

Title The contact's job title that is entered on the General tab in the
Contact Info Center.

Type The type (Client or Vendor) by which the contact is classified.

Vendor The internal reference number for the vendor record.

Vendor Address

A 'Y or N (Yes or No) value that indicates whether or not the
address is a vendor address.

Adddress4

Vendor Addressl1-Vendor

The associated vendor's' address from Address 1-Address 4.
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Vendor City The vendor's city if the contact is a vendor.

Vendor Country The vendor's country if the contact is a vendor.

Vendor Fax The vendor's fax number if the contact is a vendor.
Vendor Memo The contents of the Notes field in the Vendor Info Center if

the contact is a vendor.

Vendor Name The vendor's name if the contact is a vendor.
Vendor Phone The vendor's phone number if the contact is a vendor.
Vendor Specialty The vendor's business specialty (Interior Design, Security

Systems, and so on) if the contact is a vendor.

Vendor State The vendor's state if the contact is a vendor.

Vendor Website The vendor's Web Site address if the contact is a vendor.
Vendor Zip The vendor's ZIP code if the contact is a vendor.

Zip The contact's ZIP code.

Employee List Entity

Use the Employee List entity to create employee reports. When you use this entity, report content is
retrieved from or calculated with fields from the EM (Employee) database tables.

The Employee List entity provides you with the following fields to add to custom reports:

Employee List Field Description

#Employee Data Source Do | When you add this field to a report, it counts the items that
Not Include Labors were used to compile the information in a row on the report.

Active Company If you use the Multicompany feature in Vision, this is the
company that you have open when you run a report.

Address Line 1-Address The first, second, and third lines of the employee's address
Line 3 that are entered in the Employee Info Center.

Allow Employee to change Indicates whether or not the Allow Employee to change in
in Timesheet Timesheet check box is selected in the Default Labor Code

section of the Time tab in the Employee Info Center.

Approved for use in A variable that determines whether or not the employee
accounting applications record is approved for use when accounting transactions are
processed.
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Available For CRM users A variable that allows Customer Relationship Management
users to open and review the employee record.

Available to Accounting A variable that allows Accounting users to open and review

users the employee record.

Billing Status Indicates the billing status for the labor transaction. The
options are:

= B — Billable. Released and available for billing to the
client.

= D —To be deleted. The transaction is marked for
deletion.

= F — Final billed. Already billed to the client.

= H - Held. Temporarily hold the transaction to prevent
billing to the client.

= M — Modified. Changed in some way from its original
form.

= N — Not billable.

= O — Deleted. A transaction marked for deletion was
included in a billing run (and has been deleted).

= R — Partial Hold/Released. Part of the transaction
has already been held or released.

= T — Transferred. Moved from one project, phase,
task, or labor code to another.

= W — To be written off. Transaction has been written
off, but the invoice has not been posted.

= X — Written off. Transaction has been written off,
and the invoice has been posted.

Check hours entered A 'Y or N (Yes or No) column that indicates whether or not
against expected Vision automatically checks the hours that are entered on an
employee's timesheet and compares them to the expected
hours per day setting. This check box is on the Time tab in
the Employee Info Center.

City The employee's city.

Country The employee's country.

Create Date The date on which the employee record was created.
Create User The user who created the employee record.

Default Labor Code Level 1 The level 1 default labor code for Time timesheets for an
employee that is entered on the Time tab in the Employee
Info Center.
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Employee List Field Description

Default Labor Code Level 2

The level 2 default labor code for Time timesheets.

Default Labor Code Level 3

The level 3 default labor code for Time timesheets.

Default Labor Code Level 4

The level 4 default labor code for Time timesheets.

Default Labor Code Level 5

The level 5 default labor code for Time timesheets.

Email

The employee's email address.

Employee First Name

The employee's first name.

Employee Last Name

The employee's last name.

Employee Middle Name

The employee's middle name.

Employee Name

The employee's last name, first name.

Employee Number

The employee's identification number.

Employee Organization
Name

The organization (profit center) description of the organization
to which the employee belongs.

Employee Organization
Name

The organization (profit center) code of the organization to
which the employee belongs.

Employee Salutation

The prefix (Mr., Mrs., Ms., and so on) used with an
employee's name.

Employee Suffix

The suffix (Jr., I, and so on) used with an employee's name.

Employee Type

The employee type (Principal-P, E-Employee, M-
Management, and so on) that is entered on the Accounting
tab in the Employee Info Center.

Expense Report
Administration Approval

A Y or N (Yes or No) value that indicates whether or not the
employee can approve, before it is posted, any expense
report to which he or she has access. This column is blank if
the expense report admin level is Group. This option is on the
Expenses tab in the Employee Info Center.

Expense Report
Administration Editing

A 'Y or N (Yes or No) value that indicates whether or not the
employee can edit any expense report to which he or she has
access. This column is blank if the expense report admin
level is Group. This option is on the Expenses tab in the
Employee Info Center.

Expense Report
Administration Level

The expense report administrative level for an employee,
which can be: Staff, Group, or System. This setting is on the
Expenses tab in the Employee Info Center.
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Expense Report Group

The expense report group for which this employee is able to
access expense reports. This setting is on the Expenses tab
in the Employee Info Center.

Fax

The employee's fax number.

Hire Date

The employee's hire date.

Home Phone

The employee's home phone number.

Job Cost Type

The employee's job cost type (H-Hourly or S-Salaried) that is
entered on the Accounting tab in the Employee Info Center.

Labor Billing Category

The default category for the employee when the By Category
labor billing method is used.

Memo The Memo field on the Personal tab in the Employee Info
Center that contains comments about the employee.

Mobile Phone The employee's mobile phone number.

Modify Date The date on which the employee record was last modified.

Modify User The last user who modified the employee record.

Pay Type The payroll type for the employee — Hourly or Salary.

Raise Date The date of the employee's next raise that is entered on the

Personal tab in the Employee Info Center.

Social Security Number

The employee's Social Security number that is entered on the
Personal tab in the Employee Info Center.

State The employee's state that is entered on the Personal tab in
the Employee Info Center.
Status The employee's employment status (A-Active, I-Inactive, or

T-Terminated) that is entered on the General tab in the
Employee Info Center.

Supervisor Name

The name of the employee's supervisor that is entered on the
General tab in the Employee Info Center.

Supervisor Number

The employee number of the employee's supervisor.

Termination Date

The date that the employee was terminated from
employment. This is entered on the Personal tab in the
Employee Info Center.
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Timesheet Administration A Y or N (Yes or No) value to indicate whether the employee
Approval can approve, before it is posted, any timesheet to which he or
she has access. This option is on the Time tab in the
Employee Info Center. This column is blank if the timesheet
admin level is Group.

Timesheet Administration A 'Y or N (Yes or No) value to indicate whether an employee
Editing can edit any timesheet to which he or she has access. This

option is on the Time tab in the Employee Info Center. This

column is blank if the timesheet admin level is Group.

Timesheet Administration The timesheet administrative level (Staff, Group, or System)
Level for an employee that is entered on the Time tab in the
Employee Info Center.

Timesheet Group The timesheet group for which this employee is able to
access timesheets. This is entered on the Time tab in the
Employee Info Center.

Title The employee's title (job title, job function) that is entered on
the General tab in the Employee Info Center.

Total Hours Day The number of hours per day that the employee is generally
expected to work (entered on the Personal tab in the
Employee Info Center).

Total Pay Overtime Pct The percentage that is applied to the employee's payroll rate
to calculate standard overtime wages.

Total Pay Rate The employee's actual pay amount per payroll period (payroll
periods can be weekly, biweekly, semimonthly, or monthly).

Total Pay Special Overtime The percentage to apply to the employee's payroll rate to

Pct calculate secondary overtime wages.
Total Period The fiscal period during which the posting was made.
Total Posting Seq The transaction's posting sequence number that is assigned

by Vision during the posting process.

Total Provisional Bill Ovt 2 The percentage applied to secondary overtime hours on
Pct unposted timesheet entries when labor charges are
calculated at billing rates.

Total Provisional Bill Ovt Pct | The percentage applied to overtime hours on unposted
timesheet entries when labor charges are calculated at billing
rates.

Total Provisional Bill Rate The billing rate applied to unposted timesheet entries for this
employee when labor charges are calculated.
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Total Provisional Cost Ovt 2
Pct

The percentage applied to secondary overtime hours on
unposted timesheet entries when the labor charges are
calculated at cost rates.

Total Provisional Cost Ovt
Pct

The percentage applied to overtime hours on unposted
timesheet entries when labor charges are calculated at cost
rates.

Total Provisional Cost Rate

The cost rate applied to unposted timesheet entries for this
employee when labor charges are calculated.

Total Special Overtime
Percent

The secondary overtime percentage from the employee
record that is used to derive the special overtime rate for the
transaction. An employee's hourly rate is multiplied by the
special overtime percentage to calculate the employee's
special overtime rate.

Total Special Overtime Rate

The rate at which special overtime hours were multiplied to
derive the special overtime amount for the transaction. Vision
multiplies an employee’s hourly rate by the employee's
secondary overtime percentage to calculate the special
overtime rate.

Total Target Ratio

The percentage of an employee's time expected to be
charged to regular (revenue-producing) projects (entered on
the Accounting tab in the Employee Info Center).

Total Years W Other Firms

The number of years the employee worked with other firms
(entered on the General tab in the Employee Info Center).

Trans Type

The type of transaction: TS (Timesheet transaction) or LA
(Labor adjustment transaction).

Use total hours as standard
on Time Analysis

A Y or N (Yes or No) value that indicates whether or not
standard hours or amounts are calculated and displayed for
employees on the Time Analysis report.

Vendor Indicator

A Y or N (Yes or No) value that indicates whether or not the
employee is a consultant.

Vendor Name

The associated vendor's descriptive name.

Vendor Number

The associated vendor's identification number.

Work Phone

The employee's work phone number.

Work Phone Ext

The employee's work phone number extension.

ZIP

The employee's ZIP code.
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Employee Include Labor Entity

Use the Employee Include Labor entity to create custom Vision employee reports. When you use this
entity, report content is retrieved directly from, or calculated with fields from, the following Vision database

tables:
= EM (Employee)
= LD (Labor Detail)

= CFGEmployeeType, CFGEmployeeStatus, and CFGEmployeeGroup (Employee Configuration

tables)
= VE (Vendor)

= Organization

= BTLaborCats (Billing Configuration Table — Labor Categories)

= PR (Project)

The Employee Include Labor entity provides you with the following fields to add to custom reports:

Employee Include Labor Field | Description

#Employee Data Source
Include Labors

When you add this field to a report, it counts the items that
were used to compile the information in a row on the report.

Active Company

If you use the Multicompany feature in Vision, this is the
company that you have open when you run a report.

Address Line 1-Address Line
3

First, second, and third lines of the employee's address from
the Employee Info Center.

Allow Employee to change in
Timesheet

A Y or N (Yes or No) value that indicates whether or not the
employee can modify the default labor code on timesheets.
If Y, the employee can charge time to a labor code other
than the default. This check box is on the Time tab in the
Employee Info Center.

Approved for use in
accounting applications

Indicates whether or not the record is approved for use in
transaction processing. You may not need to include this
field on a report but it may be useful when you build queries.

Available for Accounting
users

Indicates whether or not the record is available to
accounting users. You may not need to include this field on
a report but it may be useful when you build queries.

Available for CRM users

Indicates whether or not the record is available to Customer
Relationship Management users. You may not need to
include this field on a report but it may be useful when you
build queries.
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Billing Status Indicates the billing status for the labor transaction. The
options are:

= B — Billable. Released and available for billing to
the client.

= D —To be deleted. The transaction is marked for
deletion.

= F — Final billed. Already billed to the client.

= H - Held. Temporarily hold a transaction to prevent
billing to the client.

= M — Modified. Changed in some way from its
original form.

= N — Not billable.

= O — Deleted. A transaction marked for deletion was
included in a billing run (and has been deleted).

= R — Partial Hold/Released. Part of the transaction
has already been held or released.

= T — Transferred. Moved from one project, phase,
task, or labor code to another.

= W — To be written off. Transaction has been written
off, but the invoice has not been posted.

= X — Written off. Transaction has been written off,
and the invoice has been posted.

Check hours entered against | AY or N (Yes or No) value that indicates whether or not
expected Vision compares hours posted with hours expected.

If setto Y (on the Time tab of the Employee Info Center),
Vision automatically checks the hours entered on the
employee's timesheet and compares them with the expected
hours per day setting.

City The city in which the employee resides (entered in the
Employee Info Center).

Comment Timesheet comments.

Country The country in which the employee resides (entered in the
Employee Info Center).

Create Date The date on which the employee record was created.
Create User The user who created the employee record.
Default Labor Code Level 1 Level 1 default labor code that appears on the employee's

timesheet when he or she charges time to a project.
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Default Labor Code Level 2

Level 2 default labor code that appears on the employee's
timesheet when he or she charges time to a project.

Default Labor Code Level 3

Level 3 default labor code that appears on the employee's
timesheet when he or she charges time to a project.

Default Labor Code Level 4

Level 4 default labor code that appears on the employee's
timesheet when he or she charges time to a project.

Default Labor Code Level 5

Level 5 default labor code that appears on the employee's
timesheet when he or she charges time to a project.

EMail

The employee's email address (entered in the Employee
Info Center).

Employee First Name

The employee's first name (entered in the Employee Info
Center).

Employee Last Name

The employee's last name (entered in the Employee Info
Center).

Employee Middle Name

The employee's middle name (entered in the Employee Info
Center).

Employee Name

The employee's last name, first name, and middle initial (if
included on the employee's record).

Employee Number

The individual's unique employee identification number
(entered in the Employee Info Center).

Employee Organization Name

The name of the organization that is associated with the
employee in the Employee Info Center. This value is stored
in the Name field of the Organization table. If your firm does
not use the Organization application, this field does not
display.

Employee Organization Code

The organization number (all levels) of the employee's
organization. If your firm does not use Vision's Organization
application, this field does not display.

Employee Salutation

The prefix, such as Ms. or Mr., to use with this employee's
name that is entered in the Employee Info Center.

Employee Suffix

The suffix , such as Jr. or Sr., to use with this employee's
name that is entered in the Employee Info Center.

Employee Type

The description or label of the employee's employee type,
such as Principal, Manager, or Employee that is entered in
the Employee Info Center. This value is stored in the Label
field of the CFGEmployeeType table.
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Expense Report
Administration Approval

Employee Include Labor Field | Description

A Y or N (Yes or No) value that indicates whether or not the
employee can approve, before it is posted, any expense
report to which he or she has access. This column is blank if
the expense report admin level is Group. This option is on
the Expenses tab in the Employee Info Center.

Expense Report
Administration Editing

A Y or N (Yes or No) value that indicates whether or not the
employee can edit any expense report to which he or she
has access. This column is blank if the expense report
admin level is Group. This option is on the Expenses tab in
the Employee Info Center.

Expense Report
Administration Level

The expense report administrative level for an employee,
which can be: Staff, Group, or System. This setting is on the
Expenses tab in the Employee Info Center.

Expense Report Group

The expense report group for which this employee is able to
access expense reports. This setting is on the Expenses tab
in the Employee Info Center.

Fax The employee's fax number that is entered in the Employee
Info Center.
Hire Date The date on which the employee was hired.

Home Phone

The employee's phone number that is entered in the
Employee Info Center.

Job Cost Type

The employee's job cost type (H-Hourly or S-Salaried) that
is entered on the Accounting tab in the Employee Info
Center.

Labor Billing Category

The label for the labor category that is entered for an
employee in the Employee Info Center.

Labor Codel

Employee's labor code for the task, phase, or project. An
employee may be assigned different labor codes on different
projects according to the work that the employee performs.

LD Key This is a primary key internal to the Vision LD table. Do not
add this to your report. This key is stored in the PKey field
of the LD table.

Memo The text that is entered in the Memo field on the Personal
tab of the Employee Info Center.

Mobile Phone The employee's cellular phone number that is entered in the
Employee Info Center.

Modify Date The date on which the employee record was last modified.
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Modify User The last user who last modified the employee record.

Pay Type The pay type (Hourly or Salary) that is entered on the
Payroll tab in the Employee Info Center for an employee.

Phase The identifier of the phase for which an employee reported

hours worked.

Phase Name

The name of the phase for which an employee reported
hours worked. This is the phase's short name that is entered
in the Project Info Center.

Project

The identifier of the project for which an employee reported
hours worked.

Project Name

The name of the project for which an employee reported
hours worked. This is the project's short name that is
entered in the Project Info Center.

Raise Date

The date of an employee's last raise that is entered on the
Personal tab in the Employee Info Center.

Social Security Number

An employee's Social Security number that is entered in the
Employee Information Center.

State The state where the employee resides, that is entered in the
Employee Info Center.
Status An employee's status (Active, Inactive, or Terminated) that

is entered in the Employee Info Center.

Supervisor Name

The name of the employee's supervisor that is entered in the
Employee Info Center.

Supervisor Number

The employee number of an employee's supervisor.

Task The identifier of the task for which the employee reported
hours worked.
Task Name The name of the task (the task's short name entered in the

Project Info Center).

Termination Date

The date on which the employee last worked for your firm
(entered on the Personal tab in the Employee Info Center).

Timesheet Administration
Approval

Indicates the timesheet administration approval rights of the
employee. If set to Y, the employee can approve any
timesheet to which he or she has access before it is posted.
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Timesheet Administration
Editing

A Y or N (Yes or No) value that indicates whether or not an
employee can edit any timesheet to which he or she has
access. This option is on the Time tab in the Employee Info
Center. This column is blank if the timesheet admin level is
Group.

Timesheet Administration
Level

The timesheet administrative level (Staff, Group, or System)
for an employee that is entered on the Time tab in the
Employee Info Center.

Timesheet Group

The timesheet group for which this employee is able to
access timesheets. This is entered on the Time tab in the
Employee Info Center.

Title

The employee's title (job title) that is entered in the
Employee Info Center.

Total Current Billing
Extension

For the current accounting period, the extended amount
(Hours x Rate) based on the current billing terms.

Total Current Overtime
Amount

For the current accounting period, the amount calculated for
overtime hours for the task, phase, or project. Vision
Reporting calculates overtime costs for hourly employees
differently than it does for salaried employees:

For hourly employees, the overtime amount is calculated as:

Overtime hours x Hourly labor costing rate x Overtime
percentage

For salaried employees, Vision begins by calculating the
employee's annualized hourly rate, using this equation:

Annual salary / Estimated annual regular hours, defined
as hours per week x 52

Then it calculates the overtime amount as:

Overtime hours x Annualized hourly rate x Overtime
percentage

Total Current Overtime Hours

The number of overtime hours for the task, phase, or project
for the current accounting period.

Total Current Regular
Amount

For the current accounting period, the monetary amount
calculated based on regular hours posted for the task,
phase, or project. This amount is calculated as regular hours
worked multiplied by the labor cost rate.

Total Current Regular Hours

The number of regular hours for the task, phase, or project
for the current accounting period.
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Total Current Special For the current accounting period, the amount calculated for
Overtime Amount special overtime hours for the task, phase, or project.

Total Current Special For the current accounting period, the number of special (or
Overtime Hours secondary) overtime hours for the task, phase, or project.

Special overtime is overtime that is costed and paid at a
different rate than standard overtime. If you pay separately
for special overtime, you must record these hours separately
on the timesheet. You set up secondary overtime on the
Accounting tab of the Employee Info Center.

Total Hours Day The number of hours per day the employee is generally
expected to work.

Total Job Cost Ovt 2 Pct The percentage of the employee's hourly wage that is
costed to projects when the employee works secondary
overtime hours.

Total Job Cost Ovt Pct The percentage of the employee's hourly wage that is
costed to projects when the employee works standard
overtime hours.

Total Job Cost Rate The employee's job cost rate, which is the rate at which an
employee’s hours are costed to a project.

Total JTD Billing Extension The extended amount (Hours x Rate) based on the current
billing terms job-to-date.

Total JTD Overtime Amount The job-to-date amount calculated for overtime hours.

Total JTD Overtime Hours The number of overtime hours posted job-to-date.

Total JTD Regular Amount The job-to-date amount calculated for regular hours.
Total JTD Regular Hours The job-to-date number of regular hours reported.

Total JTD Special Overtime The job-to-date amount calculated for special overtime
Amount hours.

Total JTD Special Overtime The number of special overtime hours posted job-to-date.
Hours

Total Pay Overtime Pct The percentage applied to the employee's payroll rate to

calculate standard overtime wages.

Total Pay Rate The employee's actual pay amount per payroll period
(payroll periods can be weekly, biweekly, semimonthly, or
monthly).
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Total Pay Special Overtime
Pct

The percentage to apply to the employee's payroll rate to
calculate secondary overtime wages. This can be useful if
you must pay certain overtime hours at a rate that differs

from the employee's standard overtime rate.

Total Period

The fiscal period during which the posting was made.

Total Posting Seq

The transaction's posting sequence number that is assigned
by Vision during the posting process.

Total Provisional Bill Ovt 2
Pct

The percentage that Vision applies to secondary overtime
hours on unposted timesheet entries to calculate labor
charges at billing rates.

Total Provisional Bill Ovt Pct

The percentage that Vision applies to overtime hours on
unposted timesheet entries to calculate labor charges at
billing rates.

Total Provisional Bill Rate

The billing rate that Vision applies to unposted timesheet
entries for this employee to calculate labor charges.

Total Provisional Cost Ovt 2
Pct

The percentage that Vision applies to secondary overtime
hours on unposted timesheet entries to calculate labor
charges at cost rates.

Total Provisional Cost Ovt
Pct

The percentage that Vision applies to overtime hours on
unposted timesheet entries to calculate labor charges at
cost rates.

Total Provisional Cost Rate

The cost rate that Vision applies to unposted timesheet
entries for this employee to calculate labor charges.

Total Special Overtime
Percent

The secondary overtime percentage from the employee
record that is used to derive the special overtime rate for the
transaction. Vision multiplies an employee's hourly rate by
the special overtime percentage to calculate the employee's
special overtime rate.

Total Special Overtime Rate

The rate at which special overtime hours are multiplied to
derive the special overtime amount for the transaction.
Vision multiplies an employee’s hourly rate by the
employee's secondary overtime percentage to calculate the
special overtime rate.

Total Target Ratio

The percentage of an employee's time expected to be
charged to regular (revenue-producing) projects, as
established in the Employee Info Center.

Total Years W Other Firms

The number of years that the employee worked for other
firms as entered in the Employee Info Center.
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Total YTD Billing Extension

The year-to-date extended amount (Hours x Rate) based on
the current billing terms.

Total YTD Overtime Amount

The year-to-date amount calculated for overtime hours.

Total YTD Overtime Hours

The year-to-date number of overtime hours posted.

Total YTD Regular Amount

The year-to-date amount calculated for regular hours.

Total YTD Regular Hours

The year-to-date number of regular hours posted.

Total YTD Special Overtime
Amount

The year-to-date amount calculated for special overtime
hours.

Total YTD Special Overtime
Hours

The year-to-date number of special overtime hours posted.

Trans Date

The date when the transaction was posted.

Trans Type

The type of transaction — TS (Timesheet transaction) or LA
(Labor adjustment transaction).

Use total hours as standard
on Time Analysis

A 'Y or N (Yes or No) value that indicates whether or not
standard hours or amounts for employees are calculated
and displayed on the Time Analysis report:

Vendor Indicator

A 'Y or N (Yes or No) value that indicates whether or not the
employee is a consultant.

Vendor Name

The name of the vendor if the Vendor Indicator is Y.

Vendor Number

The identification number of the vendor.

Work Phone

The employee's work phone number from the Employee Info
Center.

Work Phone Ext.

The employee's work extension.

Zip

The employee's ZIP code from the Employee Info Center.

General Ledger Entity

Use the General Ledger entity to create custom Vision general ledger reports. When you use this entity,
report content is retrieved directly from or calculated with fields from the following Vision database tables:

= LedgerAP (Expense Detail Table — Accounts Payable)
= LedgerAR (Expense Detail Table — Accounts Receivable)

= LedgerEX (Expense Detail Table)
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= LedgerMisc (Expense Detail Table — Miscellaneous Expense)
= CFGPostControl (Configuration Table — Posting Control)
= QOrganization

The General Ledger entity provides you with the following fields to add to custom reports:

General Ledger Field Description

#General Ledger Data When you add this field to a report, it counts the items that
Sources were used to compile the information in a row on the report.
Account The number of the General Ledger account.

Account Code The type of account to which detail is posted. The values are:

= 01 — Assets

= 02 — Liabilities

= 03 — Net Worth

= 04 — Revenue

= 05— Reimbursable
= 06 — Direct

= 07 — Indirect

= 08 — Other Charges

Account Description Descriptive text that indicates the type of account to which
detail is posted. The options are:

= Assets

= Liabilities

= Net Worth

= Revenue

= Reimbursable
= Direct

= Indirect

= Other Charges

Auto Entry A Y or N (Yes or No) value in the field indicates whether or
not the transaction was an automatic posting made by Vision.

Bank Code The code for the bank that is involved in the transaction.
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General Ledger Field Description

Description 1 and
Description 2

Displays Description 1 or Description 2 for each transaction
detail line. If the descriptions do not fit on a single line, the
text wraps to the next line. Vision stores two types of
descriptions for each transaction:

= Description 1 — A general description of the
transaction (for example, for an accounts payable
voucher, the name of the vendor).

= Description 2 — A more specific description of the
transaction (for example, the description entered
during Transaction Entry for a single line item on a
voucher).

PKey

Vision internal primary key.

Post Comment

Any comments entered during transaction posting.

Post Date

The date on which the transaction posted.

Organization

The organization associated with the transaction. The
organization is expressed in code form (for example, BO:AR
for Boston: Architecture).

Reference Number

The reference number that is assigned to the transaction
during Transaction Entry.

= If this is an implicit posting or an automatic posting
made by Vision, the word Auto displays in this field.

= If the transaction is historical, the word History
displays.

= If the transaction is related to revenue generation,
REVGEN displays in this field.

Total Amount

The total monetary amount of the transaction.

Total Cbamount

The cash basis total monetary amount of the transaction.

Total CB Credit Amount

The cash basis total credit monetary amount of the
transaction.

Total CB Debit Amount

The cash basis total debit monetary amount of the
transaction.

Total Credit Amount

The total credit amount that is posted to this account during
the specified period.

Total Debit Amount

The total debit amount posted to this account during the
specified period.
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General Ledger Field Description

Total Period The fiscal year and period in which the transaction was
posted (for example, 200907 for the seventh accounting
period in the year 2009).

Total Posting Sequence The transaction's posting sequence number that is assigned
by Vision during the posting process.

Transaction Date For all transactions except automatic postings, the date that
is entered for the transaction during Transaction Entry.

For automatic postings, the transaction date is the period-
ending date for the file of transactions that generated the
automatic posting.

Transaction SubType A one-letter code that represents the transaction's sub-type.
See Transaction Types in the Accounting Concepts help for a
full listing.

Transaction Type A two-letter abbreviation for the type of transaction (such as

TS for timesheet or XD for converted account data). See
Transaction Types in the Vision help system for a full listing.

TransTypePostControl The transaction type of the record in the posting log for a
particular posting sequence and period.

User Name The Vision username of the employee who initiated the
transaction.
wbs1 The project number that is associated with the transaction. If

a transaction is not project-related, no project number
displays. No project number displays for Balance Sheet
account transactions, except for those that affect accounts

receivable.
wbs2 The phase number that is associated with the transaction.
wbs3 The task number that is associated with the transaction.

Lead Entity

Use the Lead entity to create Lead reports. When you use this entity, report content is retrieved from or
calculated with fields from the Leads Info Center.

The Lead entity provides you with the following fields to add to custom reports:
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Lead Field Description

#Lead Data Sources When you add this field to a report, it counts the items that
were used to compile the information in a row on the report.

Address1-Address 3 The first, second, and third lines of the lead's address.

Business Fax The lead's business fax number.

Business Phone The lead's business phone number.

City The lead's city.

Company The company for which the lead works.

Country The lead's country.

Create Date The date on which the employee record was created.

Create User The user ID of the person who created the lead record.

Description The lead's description.

Email The lead's email address.

First Name The lead's first name.

Full Name The lead's full name that includes first, middle, and last
names.

Home Phone The lead's home phone number.

Lead Industry Code The code for the lead's industry.

Lead Industry Description The description of the lead's industry.

Last Name The lead's last name.

Lead Owner The name of the employee at your firm who is associated
with this lead.

Lead Rating The lead's rating

Lead Record Status Code The code of the lead's record status.

Lead Record Status The description of the lead's record's status — Active or

Description Inactive.

Lead Status Description The description for the lead's status, for example New,
Qualified, or Disqualified.
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Lead Field Description

Lead Status Reason Code The code for the lead's status reason.

Lead Status Reason The reason for the lead's status.

Description

LeadID Internal reference number for the lead record.

Middle Name The lead's middle name.

Mobile Phone The lead's mobile phone number.

Mod Date The date on which the lead record was last modified.

Mod User The user ID of the last person who modified the lead record.
Pager The lead's pager number.

Prefix The prefix, such as Mr. or Ms., used with the lead's name.
Rating The lead's rating.

Source The lead's source.

State The lead's state.

Suffix The sulffix, such as Jr. or lll. used with the lead's name.
Title The lead's title, such as Director, Project Manager, and so on.
Website The lead's Web site address.

Zip The lead's ZIP code.

Marketing Campaign Entity

Use the Marketing Campaign entity to create marketing reports. When you use this entity, report content

is retrieved from or calculated with fields from the Marketing Campaigns Info Center.

The Marketing Campaign entity provides you with the following fields to add to custom reports:

Marketing Campaign Field

#Marketing Campaign Data
Sources

Description

When you add this field to a report, it counts the items that
were used to compile the information in a row on the report.

Mkt Audience Code

The code for the marketing campaign's audience.

Campaign ID

Internal reference number for the marketing campaign record.
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Marketing Campaign Field

Mkt Campaign Mgr Number

Description

The employee number of the marketing campaign's campaign
manager.

Create Date

The date and time when the marketing record was created.

Create User

The user who created the marketing record.

Mktg Current Action Code

The code for the current action (Develop Invitation, Follow Up
Calls, and so on) in the marketing campaign.

Description

The description of the marketing campaign.

End Date

The marketing campaign's end date.

Mktg First Action Code

The code for the first action (Campaign Kickoff, Initial
Campaign Meeting, and so on) in the marketing campaign.

Launch Date

The marketing campaign's launch date.

Manager 3 Number

The employee number ID of an additional manager who works
on a campaign.

Mkt Audience Description

The description of the marketing campaign's audience.

Mkt Campaign Mgr Name

The employee name of the campaign’s manager.

Mkt Current Action
Description

The description for the current action (Develop Invitation,
Follow Up Calls, and so on) in the marketing campaign.

Mkt First Action Description

The description of the first action (Campaign Kickoff, Initial
Campaign Meeting, and so on) in the marketing campaign.

Mkt Mgr Name

The name of the marketing manager who works on a
campaign.

Mkt Mgr 3 Name

The name of an additional manager who works on a
campaign.

Mkt Name

The marketing campaign's name.

Mkt Next Action Description

The next action in the marketing campaign.

Mkt Number

The marketing campaign's number.

Mkt Objective Description

The marketing campaign's objective (goal), such as lead
generation, sell products, or raise awareness.

Mkt Org Name

The name of the organization in your firm to which this
marketing campaign belongs. This field displays only if your
firm uses Vision Organizations.
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Marketing Campaign Field

Mkt Status Description

Description

The current status of the campaign, such as Active,
Completed, or Planning.

Mkt Type Description

The type of campaign you plan to implement, such as Direct
Mail, Newsletter, or Seminar.

Mkt Mgr Number

The employee number of the campaign’'s marketing manager.

Mod Date The date and time when the marketing record was last
modified.
Mod User The user who last modified the marketing record.

Mktg Next Action Code

The next action in the campaign, such as Develop Invitation or
Follow Up Calls.

Mktg Objective Code

The code for the marketing campaign's objective (goal), such
as lead generation, sell products, or raise awareness.

Mktg Org Code

The code for the marketing campaign's organization.

Project Name

The marketing campaign's promotional project.

Record Status

The marketing campaign record's status.

Mktg Status Code

The marketing campaign's current status — Active,
Completed, Planning, and so on.

Total Actual Cost

The marketing campaign's actual cost.

Total Budget

The marketing campaign's budget amount.

Total Potential Responses

The total number of firms targeted by the campaign (the
potential responses) that are entered in the Universe field on
the General tab in the Marketing Campaigns Info Center.

Total Revenue

The marketing campaign's revenue.

Project Number

The marketing campaign's promotional project.

Marketing Type Code

The code for the marketing type description.

Opportunity Entity

Use the Opportunity entity to create opportunity reports. When you use this entity, report content is
retrieved from or calculated with fields from the Opportunity Info Center.

The Opportunity entity provides you with the following fields to add to custom reports:
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Opportunity Field Description

#0Opportunity Data Sources

When you add this field to a report, it counts the items that
were used to compile the information in a row on the report.

Address1-Address3

The first, second, and third lines of the opportunity address.

City The opportunity's city.

Client ID The client number of the primary client for the opportunity.
Close Date The date on which the opportunity record was closed.
Contact ID The contact number of the primary contact for the opportunity
Country The opportunity's county.

Create Date

The date and time when the opportunity record was created.

Create User

The user who created the opportunity record.

Description

The opportunity's description.

Est Completion Date

The opportunity's estimated completion date.

Est Start Date

The opportunity's estimated start date.

Mod Date The date and time when the opportunity record was last
modified.

Mod User The user who last modified the opportunity record.

Open Date The date when the opportunity record was opened.

Opportunity ID

The internal reference number for the opportunity record.

Opportunity Name

The opportunity name.

Opportunity Number

The opportunity number.

Organization Name

The associated organization's name.

Organizationl

The organization associated with the opportunity.

Primary Client

The primary client's client number.

Primary Contact

The primary contact's contact number.

Principal Name

The employee name of the opportunity's principal.

Principal Number

The employee number of the opportunity's principal.
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Opportunity Field Description

Project Manager Name The employee name of the opportunity's project manager.

Project Manager Number The employee number of the opportunity's project manager.

Regular Project Name The projgct name of the regular project created for the
opportunity.

Regular Project Number The projgct number of the regular project created for the
opportunity.

Promotional Project Name The projgct name of the promotional project created for the
opportunity.

Promotional Project Number | The projgct number of the promotional project created for the
opportunity.

Source The source of the opportunity.

Stage The opportunity's stage of development.

State The opportunity's state.

Status The opportunity's status (Active or Inactive).

Supervisor Number The employee number of the opportunity's supervisor.

Supervisor Name The employee name of the opportunity's supervisor.

Total Days Open The total number of days the opportunity has remained open.

Total Est Revenue The estimated revenue the opportunity is expected to
generate.

Total Probability The probability that the opportunity will become a project.

Total Weighted Revenue The product of Revenue and Weighted Revenue.

Type The opportunity type.

Zip The opportunity's ZIP code.

Payroll Entity

Use the Payroll entity to create custom Vision Payroll reports. When you use this entity, report content is
retrieved directly from or calculated with fields from the following Vision database tables:

= EM (Employee)
= LD (Labor Detall)
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= CFGEmployeeType, CFGEmployeeStatus, and CFGEmployeeGroup (Employee Configuration

tables)
= VE (Vendor)

= QOrganization

= BTLaborCats (Billing Configuration Table — Labor Categories and Descriptions)

= PR (Project)

The Payroll entity provides you with the following fields to add to custom reports:

Payroll Field Description

#Payroll Data Sources

When you add this field to a report, it counts the items that
were used to compile the information in a row on the report.

Active Company

If you use the Multicompany feature in Vision, this is the
company that you have open when you run a report.

Address Line 1-Address
Line 3

First, second, and third lines of the employee's address from
the Employee Info Center.

Allow Employee to change
in Timesheet

Indicates whether or not the employee can modify the default
labor code on a timesheet. If Y, the employee can charge
time to a labor code other than the default.

Approved for use in
accounting applications

Indicates whether or not the record is approved for use in
transaction processing. Although you may not need to include
this field on a report, it may be useful when building queries.

Available for CRM users

Indicates whether or not the record is available to Customer
Relationship Management users. Although you may not need
to include this field on a report, it may be useful when building
queries.

Available for Accounting
users

Indicates whether or not the record is available to accounting
users. Although you may not need to include this field on a
report, it may be useful when building queries.

BankCode

The bank code used in Payroll Processing.

Billing Status

Indicates the billing status for the labor transaction:

= B — Billable. Released and available for billing to the
client.

= D —To be deleted. The transaction is marked for
deletion.

= F — Final billed. Already billed to the client.

= H— Held. Transaction held to temporarily prevent
billing to the client.

= M — Modified. Changed in some way from its original
form.
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Payroll Field Description

= N — Not billable.

= O — Deleted. A transaction marked for deletion was
included in a billing run (and has been deleted).

= R — Partial Hold/Released. Part of the transaction
has already been held or released.

= T — Transferred. Moved from one project, phase,
task, or labor code to another.

= W — To be written off. Transaction has been written
off, but the invoice has not been posted.

= X — Written off. Transaction has been written off,
and the invoice has been posted.

Check hours entered A 'Y or N (Yes or No) value that indicates whether or not
against expected Vision compares hours entered on a timesheet with an
employee's expected hours per day setting.

CheckDate The check date entered in Payroll Processing.
CheckNo The check number issued in Payroll Processing.
City The city in which the employee resides that is entered in the

Employee Info Center.

Comment Timesheet comments.

Country The country in which the employee resides that is entered in
the Employee Info Center.

Default Labor Code Level 1 Level 1 default labor code that displays on employees'
timesheets when they charge time to a project.

Default Labor Code Level 2 Level 2 default labor code that displays on employees'
timesheets when they charge time to a project.

Default Labor Code Level 3 Level 3 default labor code that display on the employees'
timesheets when they charge time to a project.

Default Labor Code Level 4 Level 4 default labor code that displays on the employees’
timesheets when they charge time to a project.

Default Labor Code Level 5 Level 5 default labor code that displays on the employees'
timesheets when they charge time to a project.

Direct Deposit A'Y or N (Yes or No) value that indicates whether or not a
payroll payment was paid by direct deposit.

EMail The employee's email address.
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Payroll Field Description

Employee First Name

The employee's first name that is entered in the Employee
Info Center.

Employee Last Name

The employee's last name that is entered in the Employee
Info Center.

Employee Middle Name

The employee's middle name that is entered in the Employee
Info Center.

Employee Name

The employee's last name, first name, and middle initial (if it
is included on the employee's record).

Employee Number

The individual's unique employee identification number that is
entered in the Employee Info Center.

Employee Organization
Code

The name of the organization that is associated with the
employee (entered in the Employee Info Center). If your firm
does not use Vision's Organization application, this field does
not display.

Employee Organization
Code

The organization number (all levels) of the employee's
organization. If your firm does not use Vision's Organization
application, this field does not display.

Employee Salutation

The prefix (Mrs., Ms., Mr. and so on) to use with this
employee's name as entered in the Employee Info Center.

Employee Suffix

The suffix (Jr., Sr., and so on) to use with this employee's
name, as entered in the Employee Info Center.

Employee Type

The employee's employee type, such as Principal, Manager,
or Employee as entered in the Employee Info Center.

Expense Report
Administration Approval

A 'Y or N (Yes or No) value that indicates whether or not an
employee can approve (before it is posted) any expense
report to which he or she has access. This setting is on the
Expense tab in the Employee Info Center.

Expense Report
Administration Editing

A 'Y or N (Yes or No) value that indicates whether or not an
employee can edit any expense report to which he or she has
access. This setting is on the Expense tab in the Employee
Info Center.

Expense Report
Administration Level

Indicates the expense report administrative level for the
employee — Staff, Group, or System. This setting is on the
Expense tab in the Employee Info Center.

Expense Report Group

The expense report group for which this employee is able to
access expense reports.
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Fax The employee's fax number that is entered in the Employee
Info Center.
Hire Date The date on which the employee was hired (entered in the

Employee Info Center).

Home Phone

The employee's phone number that is entered in the
Employee Info Center.

Job Cost Type

The employee's job cost type (H-Hourly or S-Salaried) that is
entered on the Accounting tab in the Employee Info Center.

Labor Billing Category

The labor category (description) that is entered for an
employee in the Employee Info Center.

Memo The text entered in the Memo field on the Personal tab of the
Employee Info Center.
Mobile Phone The employee's cellular phone number that is entered in the

Employee Info Center.

Other Pay 1 Override—Other
Pay 5 Override

Any additional pay amounts added to the employee’s net pay
amount for a payroll processing run that are entered in the
Other Pay , Bonus, Other Pay 3, Other Pay 4, and Other
Pay 5 fields (General tab of the Payroll Processing form).

Ovt Hrs Override

The overtime hours entered on the Employee Review tab on
the Payroll Processing form.

Payroll Run Type

The payroll processing run type (Regular, Adjustment, or
Bonus) that is entered on the General tab of the Payroll
Processing form.

Pay Type The pay type (Hourly or Salary) that is entered for an
employee on the Payroll tab in the Employee Info Center.
Raise Date The date of the employee's last raise that is entered on the

Personal tab in the Employee Info Center.

Regular Hrs Override

The regular hours that are entered on the Employee Review
tab on the Payroll Processing form that override the regular
hours that were entered on an employee's timesheet.

Social Security Number

The employee's Social Security number that is entered in the
Employee Info Center.

Ovt 2 Hours Override

The overtime-2 hours that are entered on the Employee
Review tab on the Payroll Processing form. These override
the regular hours that were entered on an employee's
timesheet.
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Payroll Field Description

State The state where the employee resides as entered in the
Employee Info Center.
Status An employee's status (Active, Inactive, or Terminated) that is

entered on the General tab in the Employee Info Center.

Supervisor Name

The first and last name of the employee's supervisor. The
supervisor's name is entered on the General tab of the
Employee Info Center.

Supervisor Number

The employee number of the employee's supervisor that is
entered on the General tab of the Employee Info Center.

Termination Date

The date on which the employee last worked for your firm as
entered on the Personal tab in the Employee Info Center.

Timesheet Administration
Approval

A 'Y or N (Yes or No) value that indicates whether or not the
employees can approve (before it is posted) any timesheet to
which they have access. This option is on the Time tab in the
Employee Info Center.

Timesheet Administration
Editing

A Y or N (Yes or No) value that indicates whether or not an
employee can edit any timesheet to which he or she has
access. This option is on the Time tab in the Employee Info
Center. This column is blank if the timesheet admin level is
Group.

Timesheet Administration
Level

The timesheet administrative level (Staff, Group, or System)
for an employee that is entered on the Time tab in the
Employee Info Center.

Timesheet Group

The timesheet group for which this employee is able to
access timesheets. This is entered on the Time tab in the
Employee Info Center.

Title

The employee's job title entered in the Employee Info Center.

Total Other Pay 1-Total
Other Pay 5

The total of each of the five Other pay fields on the Employee
Review tab of the Payroll Processing form.

Total Gross Amount

The gross amount of a pay check.

Total Hours/Day

The number of hours per day that the employee is generally
expected to work.

Total Job Cost Ovt Pct

The percentage of the employee's hourly wage that is costed
to projects when the employee works standard overtime
hours.
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Total Job Cost Ovt 2 Pct The percentage of the employee's hourly wage that is costed
to projects when the employee works secondary overtime
hours.

Total Job Cost Rate The employee's job cost rate, which is the rate at which

Vision applies the employee’s hours as costs to a project.

Total Net Amount The net pay amount for the employee in the payroll
processing run.

Total Ovt Hrs The overtime hours that are posted by the employee for this
payroll processing run.

Total Ovt Pay The employee's overtime pay for the payroll processing run.

Total Pay Overtime Pct The percentage that is applied to the employee's payroll rate
to calculate standard overtime wages.

Total Pay Rate The employee's actual pay amount per payroll period (payroll
periods can be weekly, biweekly, semimonthly, or monthly).

Total Pay Special Overtime The percentage to apply to the employee's payroll rate to

Pct calculate secondary overtime wages.
Total Period The fiscal period during which the posting was made.
Total Post Seq The transaction's posting sequence number that is assigned

by Vision during the posting process.

Total Provisional Bill Ovt Pct | The percentage that Vision applies to overtime hours on
unposted timesheet entries to calculate labor charges at
billing rates.

Total Provisional Bill Ovt-2 The percentage that Vision applies to secondary overtime
Pct hours on unposted timesheet entries to calculate labor
charges at billing rates.

Total Provisional Bill Rate The billing rate that Vision applies to unposted timesheet
entries for this employee to calculate labor charges.

Total Provisional Cost Ovt The percentage that Vision applies to overtime hours on
Pct unposted timesheet entries to calculate labor charges at cost
rates.

Total Provisional Cost Ovt-2 | The percentage that Vision applies to secondary overtime
Pct hours on unposted timesheet entries to calculate labor
charges at cost rates.

Total Provisional Cost Rate | The cost rate that Vision applies to unposted timesheet
entries for this employee to calculate labor charges.
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Total Reg Hrs

The regular hours that are posted by the employee.

Total Reg Pay

The employee's regular pay for the payroll processing run.

Total Special Ovt Hrs

The special overtime hours that are posted by the employee
for this payroll processing run.

Total Special Ovt Pay

The employee's special overtime pay for the payroll
processing run.

Total Target Ratio

The percentage of an employee's time that is expected to be
charged to regular (revenue-producing) projects as
established in the Employee Info Center.

Total Hours

The total hours that are entered for the employee for this
payroll processing run.

Total W2 Quarter

Select Min W2 Quarter, an additional item listed for Total
W2 Quarter, to add the W2 quarter of the payroll processing
run to a report.

Total W2 Year

Select Min W2 Year, an additional item listed for Total W2
Year, to add the W2 year of the payroll processing run to a
report.

Total Withholding Code

Select Min Withholding Code, an additional item listed for
Total Withholding Code, to add the withholding code of the
payroll processing run to a report.

Total Years W Other Firms

The number of years that the employee worked for other
firms.

Use total hours as standard
on Time Analysis

A 'Y or N (Yes or No) value that indicates whether or not
standard hours or amounts for employees are calculated and
displayed on the Time Analysis report:

Vendor Indicator

A 'Y or N (Yes or No) value that indicates whether or not the
employee is a consultant.

Vendor Name

The name of the vendor if the vendor indicator is Y.

Vendor Number

The vendor number if the vendor indicator is Y.

Withholding Code

The description of the withholding code that is entered for an
item in a payroll processing run.

Withholding Code Method

The withholding code type that is entered for the withholding
code in Configuration » Payroll » Withholding Codes.
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Work Phone The employee's work phone number as entered in the

Employee Info Center.

Work Phone Ext. The employee's work phone extension.

Zip

The employee's ZIP code from the Employee Info Center.

Project Expenses Entity

Use the Project Expenses entity to create project expense reports. When you use this entity, report
content is retrieved from or calculated with fields from the following Vision database tables:

PR (Project)

LedgerEX (Expense Detall)

LedgerAP (Expense Detail Table — Accounts Payable)

LedgerAR (Expense Detail Table — Accounts Receivable)

LedgerMisc (Expense Detail Table — Miscellaneous Expense)
CFGChargeType (Configuration Table — Project Charge Types)

CL (Client)

CFGProjectStatus (Configuration Table — Project Status)
CFGRGMethods (Configuration Table — Revenue Generation Methods)
Organization (Configuration Table — Organization)

Contacts

CFGProjectType (Configuration Table — Project Types Code)
CFGPRResponsibility (Configuration Table — Primary Responsibility Codes)
Opportunity

EM (Employee)

The Project Expenses entity provides you with the following fields to add to custom reports:

Project Expenses Field Description

#Project Expenses Data When you add this field to a report, it counts the items that

Source were used to compile the information in a row on the report.

Actual Completion Date For a completed project, the date on which the project
finished.

Address1-Address3 The client's street address from the three lines of address text

entered on the client's record.

Approved for use in A 'Y or N (Yes or No) value that indicates whether or not the
accounting applications record is approved for use in transaction processing.

Although you may not need to include this field on a report, it
may be useful when building queries.

Custom Reports and Microsoft SQL Server® Reporting

Services

95



y

\ Contents of the Vision Report Model

Deltek kwwmore

Project Expenses Field Description

Available for Accounting
Users

A Y or N (Yes or No) value that indicates whether or not the
record is available to accounting users. Although you may not
need to include this field on a report, it may be useful when
building queries.

Available for CRM Users

A Y or N (Yes or No) value that indicates whether or not the
record is available to Customer Relationship Management
users. Although you may not need to include this field on a
report, it may be useful when building queries

Bid Date

The date on which your firm first bid on the project.

Bill By Default

Indicates whether or not to bill the client for certain expense
charges posted to the project. The values are:

= Yes — Always bill expense charges to the client,
regardless of whether or not the Bill by default
option is selected for the associated category in
Expense Category Configuration.

= No — Never bill expense charges to the client,
regardless of whether or not the Bill by default
option is selected for the associated category in
Expense Category Configuration.

= Category — Only bill charges to the client if the Bill
by default option is selected for the associated
category in Expense Category Configuration.

Bill Client Name

The client to be billed for the project.

Billable Message

Indicates whether or not to display an error message in the
Expense Report application when a user charges certain
expenses to this project. The values are:

= No Message — Vision does not display any
message when the category bill by default method
and the project bill by default method are different.

= Warning — Vision displays a warning message
when the category bill by default method and the
project bill by default method are different. You must
explicitly select to continue with the transaction if you
want to process the expense charge to the project
using the selected category.

= Error — Vision displays an error message when the
category bill by default method and the project bill by
default method are different. You cannot process the
expense charge to the project using the selected
category.

Billing Contact Name

The billing contact at the client firm.
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Budgeted Labor Code
Validation

The budgeted labor code check for timesheets. Options are:

N — None
W — Warning
E — Error

BudgetedLevels

The labor code levels that employees can use to charge time
to the project. The budgeted labor code level options that are
available vary based on the number of labor code levels set
up in Utilities » Key Formats » Labor Codes.

Charge Type

The project's charge type as entered on the Accounting tab in
the Project Info Center:

R — Regular. Regular projects are revenue-
producing. The costs charged to regular projects
include direct labor, direct expense, and
reimbursable expense. Detail is retained for the life of
the project.

H — Overhead. Overhead projects are not revenue-
producing. The costs charged to overhead projects
include indirect labor and indirect expense. The total
cost of these projects is distributed to regular projects
during overhead allocation. Typical overhead projects
include General Overhead, Vacation, or Sick Leave.
Overhead projects zero out when you initialize for a
new fiscal year.

P — Promotional. Use promotional projects to track
the cost of trying to acquire a job. If the job is
obtained, you can create a new regular project and
transfer the detail to it to be billed or tracked. A
promotional project is the same as an overhead
project, with this exception— Vision does not zero
out job-to-date costs at the start of each fiscal year
for promotional projects.

City

The city where the firm is located.
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CLAddress

The client address code, or description, associated with the
project. For clients who use more than one address, this field
indicates which address is associated with the project. This
field displays a description of the address on the report,
rather than the actual address. For example:

= <Default> — The default address from the client
record

= Corporate HQ — The address for the client's
headquarters

= London — The address for the client's office in London,
UK

To see a client's full address on the report, use the Client
Address (concatenated) column.

Client Alias

The alternate name used in proposals to represent a client
who wants to keep the firm's name confidential.

Client Billing Address

For clients who use more than one address, this field
indicates the one to which you are sending bills for this
project. This field displays a description of the address on the
report, rather than the actual address. For example:

= <Default> — The default billing address from the
client record.

= Corporate HQ — The address for the client's
headquarters.

Client Confidential

A 'Y or N (Yes or No) value that indicates whether or not the
client firm's name is confidential and is to be excluded from
all proposals. When you include the project in a proposal, the
alias (Client Alias) is substituted for the client name.

Completion Date Comment

The comment that is related to the completion date.

Contact Name

Your contact at the client firm.

ContactID

The contact record number for the primary contact.

Contract Date

The date on which the contract was awarded to your firm.

Country The country where the firm is located.

County The county where the firm is located.

Email The project location's email address.

End Date The completion date for the project, phase, or task.
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Estimated Completion Date | The date on which the project is/was scheduled to be
completed.

Expense Account The account number of the account that receives the debit for
the expense item.

Expense AcctName The account name of the account that receives the debit for
the expense item.

Expense BillStatus The status of the transaction. Possible values are:

= B — Billable. Released and available for billing to the
client.

= D —To be deleted. The transaction is marked for
deletion.

= F — Final billed. Already billed to the client.

= H— Held. Transaction held to temporarily prevent
billing to the client.

= M — Modified. Changed in some way from its original
form.

= N — Not billable.

= O — Deleted. A transaction marked for deletion was
included in a billing run (and has been deleted).

= R — Partial Hold/Released. Part of the transaction
has already been held or released.

= T — Transferred. Moved from one project, phase,
task, or labor code to another.

= W — To be written off. Transaction has been written
off, but the invoice has not been posted.

= X — Written off. Transaction has been written off,
and the invoice has been posted.

Expense Descl The description entered for a transaction during Transaction
Entry. If the description does not fit on a single line, the text
wraps to the next line.

Expense Desc?2 The description entered in the Detail field of the Expense
Report form if the transaction was entered through the
Expense Report application. If the description does fit on a
single line, the text wraps to the next line.

Expense Invoice The billed invoice number of the transaction.
Expense LDKey Internal primary key from the PKey field of the LedgerAP
table.
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Expense Org

The organization code that is associated with the project at
the time the transaction was posted.

Expense RefNo

The reference number, voucher number, or journal entry
number for this transaction.

Expense SubType

If the expense is a non-reimbursable or direct expense, this
field displays "Expense."

Expense TransDate

The date on which the transaction was posted or, if the detail
is from History Loading, it is the accounting period.

Expense Transfer

An asterisk in this field indicates that the transaction is an
adjustment.

Expense TransType

A two-letter abbreviation for the type of transaction (such as
EX for employee expense report). See Transaction Types in
the Accounting Concepts help for a full transaction type list.

Expense VendName

The name of the vendor who is associated with the
transaction.

Expense Vendor

The vendor number.

Expense VendOrg

The name of the organization (profit center) within your
company for which this vendor provides goods or services.

Expense VendUnit

The vendor number if the transaction type is either of the
following:

= AP — Accounts Payable voucher
= CV — Accounts Payable disbursement

The unit number if the transaction involves units.

Expense Voucher

The voucher number that is assigned to this voucher during
posting.

Expense xferwBS1 For a labor adjustment, the project from which the labor
adjustment transaction was transferred.

Expense xferwBS2 For a labor adjustment, the phase from which the labor
adjustment transaction was transferred.

Expense xferwBS3 For a labor adjustment, the task from which the labor
adjustment transaction was transferred.

ExpenseSubType Transaction subtype for the expense detail, such as Expense

or Consultant.
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ExpenseType The expense type, which can be Direct, Indirect, or
Reimbursable.
Fax The fax number at the project location.

Federal Project Indicator

A Y or N (Yes or No) value that indicates whether the current
project is a federal project.

Firm Cost Comment

Displays any comments that accompany the Firm Cost field.

Has SublLevels Turned On

A Y or N (Yes or No) value that indicates whether or not the
project, phase, or task is associated with a sub-level billing
term.

See Phase or Task Billing Terms in the Vision Help system
for information about sub-level billing terms.

Locale If your firm uses Vision Payroll, this field lists the state or
locale that is used to determine payroll tax.
Memo Displays notes for the project record as entered in the Memo

field on the General tab of the Project Info Center.

Opportunity Description

If the project record was created from an existing opportunity
record, the name of that opportunity record displays in this
field.

Opportunity ID

If the project record was created from an existing opportunity
record, the number of that opportunity record displays in this
field.

Organization Code

The unique identifier of the organization with which the
project is associated.

Organization Name

The name of the organization with which the project is
associated. Organization refers to the office within your firm
that was responsible for this project.

Phase

The unique identifier for the phase.

Phase Name

The name of the phase.

Phone

The project location's phone number.

Primary Client

The firm for which you are directly performing work on the
project.

Principal Name

The name of the principal at the firm who is associated with
this project.
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Principal Number

The unique employee number of the principal.

Project

The project identifier.

Project Long Name

The project's long name as entered in the Project Info Center.

Project Manager Name

The name of the project manager at your firm who is
associated with this project.

Project Manager Number

The unique employee number of the project manager.

Project Name

The short name of the project that is entered on the General
tab in the Project Info Center.

Project Type

The project type that is entered on the General tab in the
Project Info Center. Examples are Educational, Commercial,
Financial, Medical, Federal, and so on.

Proposal WBS1

The promotional project that is entered for a project on the
General tab of the Project Info Center.

Referable

A 'Y or N (Yes or No) value that indicates whether or not the
project can be used as a reference when you talk with
potential clients.

Responsibility

The level of responsibility that your firm has for the project
(such as Prime, Joint Venture, Consultant, and so on) that is
entered on the General tab in the Project Info Center.

= You define the responsibility codes available to your
firm in the Project Responsibility Code Table in Code
Table Configuration.

= You assign the responsibility to the project on the
General tab of the Project Info Center.

Responsibility Description

The description for the responsibility code.

Revenue Type Code

The code for the revenue type of the project that is entered
on the Budget and Revenue tab in the Project Info Center.
This is used to calculate revenue for a task, phase, or project.

The standard Vision revenue methods are:
= B — Job-to-date Billings

= M — (Job-to-date Direct Labor x Multiplier) + Job-to-
date Reimbursable Expenses @ Cost Rates

= N — No revenue generation

= P — Percent Complete + Job-to-date Reimbursable
Expenses @ Cost Rates
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= R — Job-to-date Receipts

= W — Job-to-date Billings + Work-in-Progress (WIP)
@ Billing Rates

Revenue Type Description

The description of the revenue source. For example, you
might see descriptions such as:

= JTD Billings
= JTD Billings + WIP @ Billing
= (Pct Comp*Fee) + JTD Reimb Exp

Start Date The start date of the project, phase, or task.
State The state where the firm is located.
Status The status of the project (Active, Inactive, or Dormant) that is

entered on the General tab in the Project Info Center.

Supervisor Name

The name of the supervisor at your firm who is associated
with this project. This is entered on the General tab in the
Project Info Center.

Supervisor Number

The employee number of the project's supervisor.

Task

The identifier for the task.

Task Name

The name of the task.

Total Budgeted OH Rate

The budgeted overhead rate for the project, phase, or task
(used for regular, revenue-producing projects).

= If you use the assignment method for overhead
allocation, Vision uses the budgeted overhead rate
for both budgeting and allocation purposes.

= For all other overhead allocation methods, Vision
uses the budgeted overhead rate to calculate the
overhead amount only for the project budget.

Total Compensation

The total contract value for this task, phase, or project.
Compensation is the total monetary amount your company
expects to receive and should include all labor and expenses.

Total Consultant Fee

The project's consultant fee as entered in the Project Info
Center.

Total Cost Rate Meth

If you use Vision Payroll and you selected the Enable cost
rate tables check box in Accounting Configuration, this field
displays the cost rate method for the project on the report.
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The options are:
=  From Employee Cost Rate
= From Labor Rate Table
= From Category Rate Table
= From Labor Code Table
= None

Total Cost Rate Table No

If you use Vision Payroll and you selected the Enable cost
rate tables check box in Accounting Configuration, this field
displays the cost rate table number on the report.

Total Expense Bill Amount

The monetary amount billed for the transaction.

Total Expense Cost Amount

The monetary amount of the expense transaction that is
calculated with cost rates.

Total Expense Line

The voucher line number if the transaction is of one of the
following types:

= AP — Accounts Payable voucher

= CV — Accounts Payable disbursement

Total Expense Percent
Complete

The estimate of how much of the expense budget has been
spent to date on the project, phase, or task.

Total Expense Period

The accounting period in which the transaction was posted.

Total Expense PostSeq

The transaction's posting sequence number that is assigned
by Vision during the posting process.

Total Expense Unit Billing
Rate

The amount to be charged to the client for each unit. If your
firm is using date-based rates, Vision uses the billing rate in
effect at the time the transaction was posted.

Total Expense Unit Cost
Rate

The cost amount per unit; the amount that should be costed
to the project and general ledger expense account for each

unit. If your firm uses date-based rates, Vision uses the cost
rate in effect at the time the transaction was posted.

Total Expense Unit Quantity

The number of units charged by the current transaction (for
example, 5 pipes).

Total Firm Cost

The portion of the project cost for which your firm is
responsible.

Total Labor Percent
Complete

The estimate of how far work has progressed on the project,
phase, or task.
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Total Multiplier/Amount

The multiplier, percentage, or amount by which to increase or
decrease revenue for this task, phase, or project. Revenue
methods that contain a multiplier or an amount in the
calculation use this field.

Total Overall Percent
Complete

The weighted average percent complete that is calculated as
(All percent completes x Their budgets) divided by Total
project budget.

Total PayRateMeth

If you use Vision Payroll and you selected the Enable
payrate tables for overriding payrate from Employee Info
Center check box in Payroll Configuration, this field shows
the pay rate method for the project:

=  From Employee Pay Rate
= From Labor Rate Table

= From Category Rate Table
= From Labor Code Table

=  None

Total PayRateTableNo

If you use Vision Payroll and you selected the Enable
payrate tables for overriding payrate from Employee Info
Center option in Payroll Configuration, this field displays the
pay rate table number on the report.

Total Project Cost Comment

Any comments that accompany the Total Project Cost
column. For example, this column might contain a brief
description about the cost of the project, such as "fee only,"
"Phase |," and so on.

Total Reimb Allowance

The expected amount of reimbursable expense billings for
this task, phase, or project.

Total Total Project Cost

The total cost of the project.

Total X Charge Method

This field identifies the Labor Cross Charge rate or transfer
price calculation method for this project, phase, or task that is
entered in the Cross Charge Rate Method field on the
Accounting tab of the Project Info Center. The display options
are:

= 1 — (One) Indicates a selection of Billing Terms.
This means Vision uses the project, phase, or task
billing terms to calculate the rate. If none are
specified, Vision uses the billing terms marked Use
as Project Reporting Default Terms Only in Billing,
Billing Terms. If none are specified, Vision uses the
billing terms on the Labor tab of Configuration »
Billing » Default Terms.
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= 0 — (Zero) Indicates a selection of Multiplier. This
means Vision uses the multiplier entered on the
Accounting tab of the Project Info Center.

Total X Charge Multiplier The multiplier that is used when the cross charge method is

Project and the cross charge rate is Multiplier (on the
Accounting tab in the Project Info Center).

Unit Table The unit table that is used as the default when billing unit

charges for the project.

XCharge This field indicates which Labor Cross Charge Configuration

settings currently apply to this project, phase, or task. The
options are:

= G — Global (the default setting). This indicates that
Vision uses the cross charge method entered on the
Cross Charge tab of Individual Organization setup.

= N — None.

= P — Project. This indicates that Vision uses the cross
charge method specified for the project in the Cross
Charge Rate field on the Accounting tab of the
Project Info Center.

Zip

The project location's ZIP code.

Project Labor Entity

Use the Project Labor entity to create project labor reports. When you use this entity, report content is
retrieved from or calculated with fields from the following Vision database tables:

PR (Project)

LD (Labor Detail)

CFGChargeType (Configuration Table — Project Charge Types)

CL (Client)

CFGProjectStatus (Configuration Table — Project Status)
CFGRGMethods (Configuration Table — Revenue Generation Methods)
Organization (Configuration Table — Organizations)

Contacts

CFGProjectType (Configuration Table — Project Charge Types)
CFGPRResponsibility (Configuration Table — Primary Responsibility)
Opportunity

EM (Employee)
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The fields in the Project Labor entity are also the same fields in the Project Labor Posted Only,

and Project Labor Unposted Only entities. The differences among these entities are whether or
not the entities include posted, unposted, or both types of transactions (as identified in the entity
name).

The Project Labor entity provides you with the following fields to add to custom reports:

Project Labor Field Description

#Project Labor Data Sources | When you add this field to a report, it counts the items that
were used to compile the information in a row on the report.

Actual Completion Date For any completed project, the date on which the project was
finished.
Address1-Address3 The client's street address from the three lines of address text

entered on the client's record.

Approved for use in A 'Y or N (Yes or No) value that indicates whether or not the
accounting applications record is approved for use in transaction processing. You
may not need to include this field on a report, but it may be
useful when you build queries.

Available for Accounting A Y or N (Yes or No) value that indicates whether or not the

Users record is available to accounting users. You may not need to
include this field on a report, but it may be useful when you
build queries.

Available for CRM Users A 'Y or N (Yes or No) value that indicates whether or not the

record is available to CRM users. You may not need to
include this field on a report, but it may be useful when you
build queries.

Bid Date The date on which your firm first bid on the project.

Bill By Default Indicates whether or not to bill the client for certain expense
charges posted to the project. The possible values are:

= Yes — Always bill expense charges to the client,
regardless of whether the Bill by default option is
selected for the associated category in Expense
Category Configuration.

= No — Never bill expense charges to the client,
regardless of whether the Bill by default option is
selected for the associated category in Expense
Category Configuration.

= Category — Only bill charges to the client if the Bill
by default option is selected for the associated
category in Expense Category Configuration.

Bill Client Name The client to be billed for the project.
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Billable Message

Indicates whether or not an error message displays in the
Expense Report application when a user charges certain
expenses to this project:

= No Message — Vision does not display any
message when the category bill by default method
and the project bill by default method are different.

= Warning — Vision displays a warning message
when the category bill by default method and the
project bill by default method are different. You must
explicitly choose to continue with the transaction if
you want to process the expense charge to the
project using the selected category.

= Error — Vision displays an error message when the
category bill by default method and project bill by
default method are different. You cannot process the
expense charge to the project with the selected
category.

Billing Contact Name

The billing contact at the client firm.

Budgeted Labor Code
Validation

Budgeted labor code check for timesheets. The options are:
= N —None
= W — Warning

= E—Error

BudgetedLevels

The labor code levels that employees can use when they
charge time to the project. The budgeted labor code level
options that are available vary based on the number of labor
code levels established in Utilities » Key Conversions »
Labor Codes.

Charge Type

The type of project. The options are:

= R — Regular. Regular projects are revenue-
producing. The costs charged to regular projects
include direct labor, direct expense, and
reimbursable expense. Detail is retained for the life of
the project.

= H— Overhead. Overhead projects are not revenue-
producing. The costs charged to overhead projects
include indirect labor and indirect expense. The total
cost of these projects is distributed to regular projects
during overhead allocation. Typical overhead projects
can include General Overhead, Vacation, Holiday,
Sick Leave, or Civic Duty. Overhead projects zero
out when you initialize for a new fiscal year.
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= P — Promotional. Use promotional projects when
you want to track the cost of trying to acquire a job. If
the job is obtained, you can create a new regular
project and transfer the detail to it to be billed or
tracked. A promational project is the same as an
overhead project, with this exception Vision does not
zero out job-to-date costs at the start of each fiscal
year for promotional projects.

City The city where the firm is located.

CLAddress The client address code or description that is associated with
the project. For clients with more than one address, this field
indicates which address is associated with the project. This
field displays a description of the address on the report,
rather than the actual address. For example:

= <Default> — The default address from the client
record.

= Corporate HQ — The address for the client's
headquarters.

= London — The address for the client's office in
London, UK.

If you want to see a client's full address on the report, use the
Client Address (concatenated) column.

Client Alias The alternate name used in proposals to represent a client
who wishes to keep the firm's name confidential.

Client Billing Address For clients with more than one address, this field indicates
the one to which you send bills for this project. This field
displays a description of the address on the report, rather
than the actual address. For example:

= <Default>— The default billing address from the
client record.

= Corporate HQ — The address for the client's
headquarters.

Client Confidential A 'Y or N (Yes or No) value that indicates whether or not the
client firm's name is confidential and is to be excluded from
all proposals. When you include the project in a proposal, the
alias (client alias) is substituted for the client name.

Completion Date Comment User-entered comment that is related to the completion date.

Contact Name Your contact at the client firm.

ContactID The contact record number for the primary contact.
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Contract Date

The date on which the contract was awarded to your firm.

Country The country where the firm is located.

County The county where the firm is located.

Description The project's description.

EMail The project location's email address.

End Date The completion date for the project, phase, or task.

Estimated Completion Date

The date on which the project is or was scheduled to be
completed.

Fax

The fax number at the project location.

Federal Project Indicator

A Y or N (Yes or No) value that indicates whether or not the
current project is a federal project.

Firm Cost Comment

Displays any comments that accompany the Firm Cost field.

Has SublLevels Turned On

A 'Y or N (Yes or No) value that indicates whether or not the
project, phase, or task is associated with a sub-level billing
term. See Phase or Task Billing Terms in the Vision help
system for information about sub-level billing terms.

Labor BillStatus

The status of the transaction. Possible values are:

= B — Billable. Released and available for billing to the
client.

= D —To be deleted. The transaction is marked for
deletion.

= F — Final billed. Already billed to the client.

= H— Held. Temporarily hold the transaction to
prevent billing to the client.

= M — Modified. Changed in some way from its original
form.

= N — Not billable.

= O — Deleted. A transaction marked for deletion was
included in a billing run (and has been deleted).

= R — Partial Hold/Released. Part of the transaction
has already been held or released.

= T — Transferred. Moved from one project, phase,
task, or labor code to another.

= W — To be written off. Transaction has been written
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off, but the invoice has not been posted.

= X — Written off. Transaction has been written off,
and the invoice has been posted.

Labor Code The labor code for the transaction.

Labor Comment Any timesheet comments specified appear in this field.
Labor Employee The individual's unique employee identification number.
Labor Employee Name The employee's last name, first name, and middle initial from

the employee record.

Labor Employee Org Code The organization code associated with the project at the time
the transaction was posted.

Labor Employee Type The employee type, such as Principal, Manager, or
Employee.

Labor Period The accounting period in which the transaction was posted.

Labor PKey Internal Vision primary key. The PKey from the LD table.

Labor PostSeq The transaction's posting sequence number assigned by

Vision during the posting process.

Labor TransDate The date on which the transaction was posted or, if the detail
is from History Loading, it is the accounting period.

Labor TransType A two-letter abbreviation for the type of transaction (such as
EX for employee expense report). See Transaction Types in
the Accounting Concepts help for a full listing.

Labor XferLabor Code For a labor adjustment, the labor code from which the labor
adjustment transaction was transferred.

Labor xferwBS1 For a labor adjustment, the project from which the labor
adjustment transaction was transferred.

Labor xferwBS2 For a labor adjustment, the phase from which the labor
adjustment transaction was transferred.

Labor xferwBS3 For a labor adjustment, the task from which the labor
adjustment transaction was transferred.

LaborCode The labor code for which the employee reported hours
worked. An employee may be assigned different labor codes
on different projects, according to the work being performed.
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Locale If your firm uses Vision Payroll, this field lists the state or
locale used to determine payroll tax.
Memo Any notes for the project record, as entered in the Memo field

on the General tab of the Project Info Center.

Opportunity Description

If the project record was created from an existing opportunity
record, the name of that opportunity record displays in this
field.

Opportunity ID

If the project record was created from an existing opportunity
record, the number of that opportunity record displays in this
field.

Organization Code

The unique identifier of the organization with which the
project is associated.

Organization Name

The name of the organization with which the project is
associated. Organization refers to the office within your firm
that was responsible for this project.

Phase

The unique identifier for the phase.

Phase Name

The name of the phase.

Phone

The project location's phone number.

Primary Client

The firm for which you are directly performing work on the
project.

Principal Name

The name of the principal at the firm who is associated with
this project.

Principal Number

The employee number of the principal.

Project

The project identifier.

Project Long Name

The project's long name that is entered in the Project Info
Center.

Project Manager Name

The name of the project manager at your firm who is
associated with this project.

Project Manager Number

The employee number of the project manager.

Project Name

The short name of the project.

Project Type

The type of project, such as Educational, Commercial,
Financial, Medical, Federal, and so on.
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Proposal WBS1

The promotional project linked to the project record.

Referable

A Y or N (Yes or No) value that indicates whether or not the
project can be used as a reference when you talk with
potential clients.

Responsibility

The level of responsibility that your firm has for the project,
such as Prime, Joint Venture, or Consultant.

= You define the responsibility codes available to your
firm in the Project Responsibility Code Table in Code
Table Configuration.

= You assign the responsibility to a project on the
General tab of the Project Info Center.

Responsibility Description

The description for the responsibility code that is entered in
the Project Responsibility Code Table.

Revenue Type Code

The code that is used to calculate revenue for this task,
phase, or project. The standard revenue methods are:

= B — Job-to-date Billings

= M — (Job-to-date Direct Labor x Multiplier) + Job-to-
date Reimbursable Expenses @ Cost Rates

= N — No revenue generation

= P — Percent Complete + Job-to-date Reimbursable
Expenses @ Cost Rates

= R — Job-to-date Receipts

= W — Job-to-date Billings + Work-in-Progress (WIP)
@ Billing Rates

Revenue Type Description

The description of the revenue source, such as:
= JTD Billings
= JTD Billings + WIP @ Billing
= (Pct Comp*Fee) + JTD Reimb Exp

Start Date The start date of the project, phase, or task.
State The state where the firm is located.
Status The status of the project (Active, Inactive, or Dormant) that is

entered on the General tab in the Project Info Center.

Supervisor Name

The name of the supervisor (at your firm) for a project that is
entered on the General tab in the Project Info Center.
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Supervisor Number

The employee number of the supervisor.

Task

The unique identifier for the task.

Task Name

The name of the task.

Total Budgeted OH Rate

The budgeted overhead rate for the project, phase, or task
(used for regular, revenue-producing projects).

If you use the assignment method for overhead allocation,
Vision uses the budgeted overhead rate for both budgeting
and allocation purposes. For all other overhead allocation
methods, Vision uses the budgeted overhead rate to
calculate the overhead amount only for the project budget.

Total Compensation

The total contract value for this task, phase, or project.
Compensation is the total monetary amount you expect to
receive; this amount should include all labor and expenses.

Total Consultant Fee

The project's consultant fee as entered in the Project Info
Center.

Total Cost Rate Meth

If you use Vision Payroll and you selected the Enable cost
rate tables check box in Accounting Configuration, this field
displays the cost rate method for the project. The options are:

=  From Employee Cost Rate
= From Labor Rate Table
= From Category Rate Table
= From Labor Code Table

=  None

Total Cost Rate Table No

If you use Vision Payroll and you selected the Enable cost
rate tables check box in Accounting Configuration, this field
displays the cost rate table number on the report.

Total Expense Percent
Complete

The estimate of how much of the expense budget has been
spent to date on the project, phase, or task.

Total Firm Cost

The portion of the project cost for which your firm is
responsible.

Total Labor Bill Amount

The billing amount that Vision applies to timesheet entries for
this employee when calculating labor charges.

Total Labor Bill Rate

The billing rate that Vision applies to timesheet entries for this
employee when calculating labor charges.
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Total Labor Category

The employee's labor category, such as Principal, Project
Manager, or Architect.

Total Labor Cost Amount

The amount calculated for regular hours for the task, phase,
or project. This amount is calculated as regular hours worked
multiplied by the labor cost rate.

Total Labor Cost Overtime
Amount

The amount calculated for overtime hours for the task, phase,
or project.

Vision Reporting calculates overtime costs for hourly
employees differently than it does for salaried employees.

For hourly employees, the overtime amount is calculated as:

Overtime hours x Hourly labor costing rate x Overtime
percentage

For salaried employees, Vision begins by calculating the
employee's annualized hourly rate, using this equation:

Annual salary / Estimated annual regular hours, defined
as Hours per week x 52

Then calculates the overtime amount as:

Overtime hours x Annualized hourly rate x Overtime
percentage

Total Labor Cost Overtime
Rate

The cost rate Vision applies to overtime hours for this
employee when calculating labor charges.

Total Labor Cost Rate

The cost rate that Vision applies to timesheet entries for this
employee to calculate labor charges.

Total Labor Cost Special
Overtime Amount

The amount calculated for special overtime hours for the
task, phase, or project.

Total Labor Cost Special
Overtime Rate

The rate at which special (secondary) overtime hours are
multiplied to derive the special overtime amount for the
transaction. Vision multiplies an employee's hourly rate by the
employee's secondary overtime percentage to calculate the
special overtime rate.

Total Labor Overtime Hours

The number of overtime hours the employee reported for the
task, phase, or project.

Total Labor Overtime
Percent

The rate at which overtime hours were multiplied to derive the
overtime amount for the transaction. Vision multiplies an
employee's hourly rate by the employee's overtime
percentage to calculate the overtime rate.

Total Labor Percent
Complete

The estimate of how far work has progressed on the project,
phase, or task.

Custom Reports and Microsoft SQL Server® Reporting

Services

115



\

y

Contents of the Vision Report Model

Deltek kwwmore

Project Labor Field Description

Total Labor Regular Hours

The number of regular hours the employee reported for the
task, phase, or project.

Total Labor Special
Overtime Hours

The number of special (secondary) overtime hours the
employee reported for the task, phase, or project.

Special overtime is costed and paid at a different rate than
standard overtime. If you pay separately for special overtime,
you must record these hours separately on the timesheet.

You set secondary overtime on the Accounting tab of the
Employee Info Center.

Total Labor Special
Overtime Percent

The secondary overtime percentage from the employee
record, used to derive the special overtime rate for the
transaction. Vision multiplies an employee's hourly rate by the
special overtime percentage to calculate the employee's
special overtime rate.

Total Multiplier Amount

The multiplier, percentage, or amount by which to increase or
decrease revenue for this task, phase, or project. Revenue
methods that contain a multiplier or an amount in the
calculation use this field.

Total Overall Percent
Complete

The weighted average percent complete that is calculated as
(All percent completes x Their budgets) divided by the Total
project budget.

Total Pay Rate Table No

If you use Vision Payroll and you selected the Enable
payrate tables for overriding payrate from Employee Info
Center check box in Payroll Configuration, this field displays
the pay rate table number on the report.

Total Pay Rate Meth

If you use Vision Payroll and you selected the Enable
payrate tables for overriding payrate from Employee Info
Center option in Payroll Configuration, this field shows the
pay rate method for the project. The options are:

= From Employee Pay Rate
= From Labor Rate Table

= From Category Rate Table
= From Labor Code Table

=  None

Total Project Cost Comment

Any comments that accompany the Total Project Cost
column. For example, this column might contain a brief
description about the cost of the project, such as "fee only,"
"Phase I," and so on.
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Total Reimb Allowance

The expected amount of reimbursable expense billings for
this task, phase, or project.

Total Total Project Cost

The total cost of the project.

Total X Charge Multiplier

The multiplier used when the Cross Charge Method is
Project, and the Cross Charge Rate is set to Multiplier on
the Accounting tab of the Project Info Center.

Total X Charge Method

This field identifies the Labor Cross Charge rate or transfer
price calculation method for this project/phase/task that is
entered n the Cross Charge Rate field on the Accounting tab
of the Project Info Center. Display options are:

= 1 — (One) Indicates a selection of Billing Terms.
This means Vision uses the project/phase/tasks
billing terms to calculate the rate. If none are
specified, Vision uses the billing terms marked Use
as Project Reporting Default Terms Only in Billing,
Billing Terms. If none are specified, Vision uses the
billing terms on the Labor tab of Configuration »
Billing » Default Terms.

= 0 — (Zero) Indicates a selection of Multiplier. This
means Vision uses the multiplier entered on the
Accounting tab of the Project Info Center.

Unit Table The unit table that is used as the default when billing unit
charges for the project.

XCharge This field indicates which Labor Cross Charge configuration
settings currently apply to this project/phase/task. Valid
options are:

= G — Global (the default setting). This option
indicates that Vision uses the cross charge method
specified on the Cross Charge tab of Individual
Organization setup.

= N — None

= P — Project. This option indicates that Vision uses
the cross charge method specified for the project in
the Cross Charge Rate field on the Accounting tab
of Project Info Center.

Zip The project location's ZIP code.

Project Labor Posted Only Entity

Use the Project Labor Posted Only entity to create project labor reports that include only posted
transactions. The fields are the same fields as those listed in the "Project Labor" section, above.
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Project Labor Unposted Only Entity

Use the Project Labor Unposted Only entity to create project labor reports that include only unposted
transactions. The fields are the same fields as those listed in the "Project Labor" section, above.

Project List Entity

Use the Project List entity to create project list reports. When you use this entity, report content is
retrieved from or calculated with fields from the following Vision database tables:

= PR (Project)

= CFGChargeType (Configuration Table — Project Charge Types)

= CL (Client)

= CFGProjectStatus (Configuration Table — Project Status)

= CFGRGMethods (Configuration Table — Revenue Generation Methods)
= Organization (Configuration Table — Organizations)

= Contacts

= CFGProjectType (Configuration Table — Project Charge Types)

= CFGPRResponsibility (Configuration Table — Primary Responsibility)
= Opportunity

= EM (Employee)

The Project List entity provides you with the following fields to add to custom reports:

Project List Field Description

#Project List Data Sources When you add this field to a report, it counts the items that
were used to compile the information in a row on the report.

Actual Completion Date For any completed project, the date on which the project was
finished.
Address1-Address3 The first, second, and third address lines of the client's street

address entered for the client's record.

Approved for use in A 'Y or N (Yes or No) value that indicates whether or not the
accounting applications record is approved for use in transaction processing. You
may not need to include this field on a report, but it may be
useful when you build queries

Available to Accounting A 'Y or N (Yes or No) value that indicates whether or not the

Users record is available to accounting users. You may not need to
include this field on a report, but it may be useful when you
build queries.
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Available to CRM Users A Y or N (Yes or No) value that indicates whether or not the
record is available to Customer Relationship Management
users. You may not need to include this field on a report, but
it may be useful when you build queries.

Bid Date The date on which your firm first bid on the project.

Bill By Default Indicates whether or not to bill the client for certain expense
charges posted to the project. The values are:

= Yes — Always bill expense charges to the client,
regardless of whether the Bill by default check box
is selected for the associated category in Expense
Category Configuration.

= No — Never bill expense charges to the client,
regardless of whether the Bill by default check box
is selected for the associated category in Expense
Category Configuration.

= Category — Only bill charges to the client if the Bill
by default check box is selected for the associated
category in Expense Category Configuration.

Bill Client Name The client to be billed for the project.

Billable Message Indicates whether or not to display an error message in the
Expense Report application when a user charges certain
expenses to this project. The values are:

= No Message — Vision does not display any
message when the category bill by default method
and the project bill by default method are different.

= Warning — Vision displays a warning message
when the category bill by default method and the
project bill by default method are different. You must
explicitly choose to continue with the transaction if
you want to process the expense charge to the
project using the selected category.

= Error — Vision displays an error message when the
category bill by default method and the project bill by
default method are different. You cannot process the
expense charge to the project using the selected

category.

Billing Contact Name The contact name to be billed for the project.
Budgeted Labor Code Budgeted labor code check for timesheets. The options are:
Validation

= N — None

= W — Warning

= E— Error
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BudgetedLevels The labor code levels that employees can use when they
charge time to the project. The budgeted labor code level
options that are available vary based on the number of labor
code levels that you establish in Utilities » Key Conversions
» Labor Codes.

Charge Type The project's charge type as entered on the Accounting tab in
the Project Info Center. The options are:

= R — Regular. Regular projects are revenue-
producing. The costs charged to regular projects
include direct labor, direct expense, and
reimbursable expense. Detail is retained for the life of
the project.

= H— Overhead. Overhead projects are not revenue-
producing. The costs charged to overhead projects
include indirect labor and indirect expense. The total
cost of these projects is distributed to regular projects
during overhead allocation. Typical overhead projects
can include: General Overhead, Vacation, Sick
Leave, Holiday, or Civic Duty. Overhead projects
zero out when you initialize for a new fiscal year.

= P — Promotional. Use promotional projects to track
the cost of trying to acquire a job. If the job is
obtained, you can create a new regular project and
transfer the detail to it to be billed or tracked. A
promotional project is the same as an overhead
project, with this exception—Vision does not zero out
job-to-date costs at the start of each fiscal year for
promotional projects.

City The city where the firm is located.
CLAddress The client address code.
Client Alias The alternate name used in proposals to represent a client

who wishes to keep the firm's name confidential.

Client Billing Address For clients with more than one address, this field indicates
the address to which you are sending bills for this project.
This field displays a description of the address on the report,
rather than the actual address. For example, you might see:

= <Default> — The default billing address from the
client record.

= Corporate HQ — The address for the client's
headquarters.
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Client Confidential

A Y or N (Yes or No) value that indicates whether or not the
client firm's name is confidential and is to be excluded from
all proposals. When you include the project in a proposal, the
alias (client alias) is substituted for the client name.

Completion Date Comment

User-entered comment related to the completion date.

Contact Name

Your contact at the client firm.

ContactID

The contact record number for the primary contact.

Contract Date

The date on which the contract was awarded to your firm.

Country The country where the firm is located.

County The county where the firm is located.

Description The project's description.

Email The project location's email address.

End Date The completion date for the project, phase, or task.

Estimated Completion Date

The date on which the project is/was scheduled to be
completed.

Fax

The fax number at the project location.

Federal Project Indicator

A 'Y or N (Yes or No) value that indicates whether or not the
current project is a federal project.

Firm Cost Comment

Displays any comments that accompany the Firm Cost field.

Has SublLevels Turned On

A 'Y or N (Yes or No) value that indicates whether or not the
project, phase, or task is associated with a sub-level billing
term. See Phase or Task Billing Terms in the Vision help
system for information about sub-level billing terms.

Locale If your firm uses Vision Payroll, this field lists the state or
locale used to determine payroll tax.
Memo Displays notes specified for the project record that are

entered in the Memo field on the General tab of the Project
Info Center.

Opportunity Description

If the project record was created from an existing opportunity
record, the name of that opportunity displays in this field.

Opportunity ID

If the project record was created from an existing opportunity
record, the number of that opportunity displays in this field.
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Organization Code

The identifier of the organization with which the project is
associated.

Organization Name

The name of the organization with which the project is
associated. Organization refers to the office or profit center
within your firm that was responsible for this project.

Phase

The unique identifier for the phase.

Phase Name

The name of the phase.

Phone

The project location's phone number.

Primary Client

The firm for which you are directly performing work on the
project.

Principal Name

The name of the principal at the firm who is associated with
this project.

Principal Number

The employee number of the principal.

Project

The project identifier.

Project Long Name

The project's long name entered in the Project Info Center.

Project Manager Name

The name of the project manager at your firm who is
associated with this project.

Project Manager Number

The employee number of the project manager.

Project Name

The short name of the project.

Project Type

The type of project, such as Educational, Commercial,
Financial, Medical, or Federal.

Proposal WBS1

The promotional project linked to the project record.

Referable

A Y or N (Yes or No) value that indicates whether or not the
project can be used as a reference when you talk with
potential clients.

Responsibility

The level of responsibility that your firm has for the project,
such as Prime, Joint Venture, Consultant, and so on.

= You determine the responsibility codes available to
your firm in the Project Responsibility Code Table in
Code Table Configuration.

= You assign the responsibility to a project on the
General tab of the Project Info Center.
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Responsibility Description The description for the responsibility code entered in the
Project Responsibility Code Table.

Revenue Type Code This is used to calculate revenue for this task, phase, or
project. Vision provides six standard revenue methods:

= B — Job-to-date Billings

= M — (Job-to-date Direct Labor x Multiplier) + Job-to-
date Reimbursable Expenses @ Cost Rates

= N — No revenue generation

= P — Percent Complete + Job-to-date Reimbursable
Expenses @ Cost Rates

= R — Job-to-date Receipts
= W — Job-to-date Billings + Work-in-Progress (WIP)

@ Billing Rates
Revenue Type Description The description of the revenue source. For example:
= JTD Billings

= JTD Billings + WIP @ Billing
= (Pct Comp*Fee) + JTD Reimb Exp

Start Date The start date of the project, phase, or task.

State The state where the firm is located.

Status The status (Active, Inactive, or Dormant) of the project.
Supervisor Name The name of the supervisor at your firm who is associated

with this project.

Supervisor Number The employee number of the supervisor.

Task The unique identifier for the task.

Task Name The name of the task.

Total Budgeted OH Rate The budgeted overhead rate for the project, phase, or task

This is used for regular, revenue-producing projects.

= If you use the assignment method for overhead
allocation, Vision uses the budgeted overhead rate
for both budgeting and allocation purposes.

=  For all other overhead allocation methods, Vision
uses the budgeted overhead rate to calculate the
overhead amount only for the project budget.
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Total Compensation

The total contract value for this task, phase, or project. It is
the total monetary amount that your company expects to
receive; it includes all labor and expenses.

Total Consultant Fee

The project's consultant fee that is entered in the Project Info
Center.

Total Cost Rate Meth

If you use Vision Payroll, and you have selected the Enable
cost rate tables check box in Accounting Configuration, this
field displays the cost rate method for the project on the
report. The options are:

=  From Employee Cost Rate
= From Labor Rate Table
= From Category Rate Table
= From Labor Code Table

=  None

Total Cost Rate Table No

If you use Vision Payroll and you have selected the Enable
cost rate tables check box in Accounting Configuration, this
field displays the cost rate table number on the report.

Total Expense Percent
Complete

The estimate of how much of the expense budget has been
spent to date on the project, phase, or task.

Total Firm Cost

The portion of the project's total cost for which your firm is
responsible.

Total Labor Percent
Complete

The estimate of how far work has progressed on the project,
phase, or task.

Total Multiplier/Amount

The multiplier, percentage, or amount by which to increase or
decrease revenue for this task, phase, or project. Revenue
methods that contain a multiplier or an amount in the
calculation use this field.

Total Overall Percent
Complete

The weighted average percent complete, calculated as (all
percent completes x their budgets) divided by the total project
budget.
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Total Pay Rate Meth

If you use Vision Payroll and you selected the Enable
payrate tables for overriding payrate from Employee Info
Center option in Payroll Configuration, this field shows the
pay rate method for the project. The options are:

= From Employee Pay Rate
= From Labor Rate Table

= From Category Rate Table
= From Labor Code Table

=  None

Total Pay Rate Table No

If you use Vision Payroll, and you selected the Enable
payrate tables for overriding payrate from Employee Info
Center check box in Payroll Configuration, this field displays
the pay rate table number on the report.

Total Project Cost Comment

Any comments that accompany the Total Project Cost
column. For example, this column might contain a brief
description about the cost of the project, such as "fee only,"
"Phase |," and so on.

Total Reimb Allowance

The expected amount of reimbursable expense billings for
this task, phase, or project

Total Project Cost

The total cost of the project.

Total X Charge Method

This field indicates the Labor Cross Charge rate or transfer
price calculation method for this project/phase/task, as
established in the Cross Charge Rate field on the
Accounting tab of the Project Info Center.

The display options are:

= 1— A1 (one)indicates a selection of Billing Terms.
This means Vision uses the project/phase/tasks
billing terms to calculate the rate. If none are
specified, Vision uses the billing terms marked Use
as Project Reporting Default Terms Only in Billing,
Billing Terms. If none are specified, Vision uses the
billing terms on the Labor tab of Configuration »
Billing » Default Terms.

= 0 — A0 (zero) indicates a selection of Multiplier. This
means Vision uses the multiplier entered on the
Accounting tab of the Project Info Center.

Total X Charge Multiplier

The multiplier that is used when the Cross Charge Method
is Project, and the Cross Charge Rate is set to Multiplier
from the Accounting tab of the Project Info Center.
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Unit Table The unit table used as the default when billing unit charges
for the project.

XCharge This field indicates which Labor Cross Charge configuration
settings currently apply to this project/phase/task. The
options are:

= G — Global (the default setting). This option
indicates that Vision uses the cross charge method
specified on the Cross Charge tab of Individual
Organization setup.

= N — None

= P — Project. This option indicates that Vision uses
the cross charge method specified for the project in
the Cross Charge Rate field on the Accounting tab
of the Project Info Center.

Zip The project location's ZIP code.

Project Summary at Billing Entity

Use the Project Summary at Billing entity to create summary reports with project billing information. When
you use this entity, report content is retrieved from or calculated with fields from the following Vision
database tables:

= PR (Project)

= CFGChargeType (Configuration Table — Project Charge Types)

= Client (CL)

= CFGProjectStatus Configuration Table — Project Status)

= CFGRGMethods (Configuration Table — Revenue Generation Methods)
= Organization (Configuration Table — Organizations)

= Contacts

= CFGProjectType (Configuration Table — Project Charge Types)

= CFGPRResponsibility (Configuration Table — Primary Responsibility)
= Opportunity

= EM (Employee)

The fields in the Project Summary at Cost entity are the same fields that are in the Project
Summary at Billing entity, except they use cost rates rather than billing rates.

The Project Summary at Billing entity provides the following fields to add to custom reports:
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#Project Summary Data Source
Report at Billing

When you add this field to a report, it counts the items that
were used to compile the information in a row on the
report.

ClientID The record number (identifier) for the client record.

ClientName The name of the client for this project.

ContactID The record number (identifier) for the contact record.

ContactName The name of the contact for this project.

PhaseManagerName The name of the manager at your firm who is associated
with this phase.

PhaseManagerNumber The employee number of the manager at your firm who is
associated with this phase.

PhaseName The phase name.

PhaseNumber The phase identifier.

PhasePrincipalName

The name of the principal at your firm who is associated
with this phase.

PhasePrincipalNumber

The employee number of the principal at your firm who is
associated with this phase.

PhaseSupervisorName

The name of the supervisor at your firm who is associated
with this phase.

PhaseSupervisorNumber

The employee number of the supervisor at your firm who
is associated with this phase.

PKey

An internal primary key.

Project Charge Type

The charge type of the project that is entered on the
Accounting tab in the Project Info Center. The options are:

= R Regular — Regular projects are revenue-
producing. The costs charged to regular projects
include direct labor, direct expense, and
reimbursable expense. Detail is retained for the
life of the project.

= H Overhead — Overhead projects are not
revenue-producing. The costs charged to
overhead projects include indirect labor and
indirect expense. The total cost of these projects
is distributed to regular projects during overhead
allocation. Typical overhead projects can include
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General Overhead, Vacation, and Sick Leave.
Overhead projects zero out when you initialize for
a new fiscal year.

= P Promotional — Use promotional projects when
you want to track the cost of trying to acquire a
job. If the job is obtained, you can create a new
regular project and transfer the detail to it to be
billed or tracked. A promotional project is the
same as an overhead project, with this exception -
Vision does not zero out job-to-date costs at the
start of each fiscal year for promotional projects.

Project Revenue Type

The revenue type is the code used for calculating revenue
for this project. Vision provides six standard revenue
methods:

= B — Job-to-date Billings

= M — (Job-to-date Direct Labor x Multiplier) + Job-
to-date Reimbursable Expenses @ Cost Rates

= N — No revenue generation

= P — Percent Complete + Job-to-date
Reimbursable Expenses @ Cost Rates

= R — Job-to-date Receipts

= W — Job-to-date Billings + Work-in-Progress
(WIP) @ Billing Rates

ProjectManagerName

The name of the project manager at your firm who is
associated with this project.

ProjectManagerNumber

The employee number of the project manager at your firm
who is associated with this project.

ProjectName

The project name.

ProjectNumber

The project identifier.

ProjectPrincipalName

The name of the principal at your firm who is associated
with this project.

ProjectPrincipalNumber

The employee number of the principal at your firm who is
associated with this project.

ProjectSupervisorName

The name of the supervisor at your firm who is associated
with this project.

ProjectSupervisorNumber

The employee number of the supervisor at your firm who
is associated with this project.
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Record Type Code Internal record codes:

= 0 — Project Info

= 1— Labor

= 2 — Overhead

= 3 — Direct expenses

= 5 —If charge type is R, then Reimb Expenses,
otherwise, Expenses.

= 6 — Indirect expenses
= 7 — AR, Revenue
= 9 — Billed, Received

Record Type Description The description for the internal record type codes.

Resource Planning Detail Value | The value that represents the setting that is selected in the
Planning Details field on the Option tab in Planning »
Resource Management » Resource Utilization.

This setting determines how records display on the
Resource Utilization grid.

= Include Numbers with Plan Names

= Include Numbers with Plan Level Names

Resource Planning wbs level The lowest level of the work breakdown structure that a
plan has.

SubLevell Variable that indicates whether or not the project has
phases.

SubLevel2 Variable that indicates whether or not the phase has
tasks.

TaskManagerName The name of the manager at your firm who is associated

with this task.

TaskManagerNumber The employee number of the manager at your firm who is
associated with this task.

TaskName The task name.
TaskNumber The task identifier.
TaskPrincipalName The name of the principal at your firm who is associated

with this task.
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TaskPrincipalNumber

The employee number of the principal at your firm who is
associated with this task.

TaskSupervisorName

The name of the supervisor at your firm who is associated
with this task.

TaskSupervisorNumber

The employee number of the supervisor at your firm who
is associated with this task.

Total Hours Percent Complete

Select Min Amount Percent Complete, an additional
item for Total Hours Percent Complete to include the
project's total hours percent complete on a report.

Total Baseline Amount

The sum of all the baseline amounts (labor, expense, and
unit) for a plan.

Total Budgeted Amount

The total monetary amount budgeted for this project.

Total Budgeted Hours

The hours budgeted for this project.

Total Current Amount

The labor amount spent for the current accounting period.

Total Current AR Amount

The amount billed but not yet received for the current
accounting period.

Total Current Billed

The total amount billed (Labor + Fee + Consultants +
Expenses + Units + Interest Billed) for the current
accounting period.

Total Current Direct

The total direct expenses for the current accounting
period.

Total Current Gross Margin

The gross margin for the current accounting period.

Total Revenue — (Labor + Direct + Reimbursable Amounts
Spent)

Firms that do not allocate overhead show project results
on a gross margin basis.

Total Current Hours

Labor hours spent for this project for the current
accounting period.

Total Current Net Revenue

The total revenue for the project for the current accounting
period.

Non-Labor Direct Expense + Reimbursable Expense

Total Current Profit

The amount of profit calculated for this project for the
current accounting period.

Revenue — Spent = Profit
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Total Current Received The amount received for this project for the current
accounting period.

Total Current Revenue The amount of revenue calculated for this project for the
current accounting period.

Total Current Unbilled The amount of revenue not yet billed for this project for the
current period.

Revenue — Billed = Unbilled

Total EAC Amount EAC = Estimate at Completion.

The estimate of the total monetary amount that will have
been incurred at the completion of the project.

Total ETC Amount Estimate to Complete Amount

The estimate of the total additional monetary amount—
beyond the spent to date—required to complete the work.

Total Hours EAC Estimate at Completion Hours

The estimate of the total number of hours that will have
been worked at the completion of a project.

Total Hours ETC Estimate to Complete Hours

The estimate of the total additional labor hours—beyond
those worked to date—that are required to complete the
work.

Total Hours Percent Complete The project manager’s stated percentage of work effort
(total hours) completed on this project.

Total JTD Amount The job-to-date labor amount spent.

Total JTD AR Amount The job-to-date amount billed but not yet received.

Total JTD Billed The job-to-date amount billed (Labor + Fee + Consultants
+ Expenses + Units + Interest Billed).

Total JTD Direct The total direct expenses for the current accounting
period.

Total JTD Gross Margin The job-to-date gross margin.

JTD Total Revenue — (JTD Labor + JTD Direct + JTD
Reimbursable Amounts Spent)

Firms that do not allocate overhead show project results
on a gross margin basis.
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Total JTD Hours

The job-to-date labor hours spent for a project.

Total JTD Net Revenue

The job-to-date revenue for a project.

Non-Labor Direct Expense + Reimbursable Expense

Total JTD Profit

The job-to-date profit.

Revenue — Spent = Profit

Total JTD Received

The job-to-date amount received for a project.

Total JTD Revenue

The job-to-date amount of revenue calculated for a
project.

Total JTD Unbilled

The job-to-date amount of revenue not yet billed for a
project.

Revenue — Billed = Unbilled

Total Labor Budgeted for
Overhead

The total monetary amount of overhead budgeted for a
project.

Total Planned Amount

The sum of all the plan amounts (labor, expense, and
unit).

Total Project Consultant Fee

The expected amount of reimbursable consultant fees for
a project. This amount includes any markups on
consultant professional services.

Total Project Fee

A project's total fee.

Total Project Multiplier/Amount

The multiplier, percentage, or amount by which to
increase or decrease revenue for a project. Revenue
methods that contain a multiplier or an amount in the
calculation use this field.

Total Project Percent Complete

The project manager’s stated percentage of work effort
completed on a project.

Total Project Reimb Allowance

The expected amount of reimbursable expense billings for
a project.

Total Rpdata

Resource Planning

Total Resource Planning
Percent Complete

The overall percent complete for the cost budget (from the
PctComplete field in the RP Plan table.

Total YTD Amount

The year-to-date labor amount spent.

Total YTD AR Amount

The year-to-date amount billed but not yet received.
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Total YTD Billed The year-to-date amount billed (Labor + Fee +
Consultants + Expenses + Units + Interest Billed).

Total YTD Direct The year-to-date direct expenses.

Total YTD Gross Margin The year-to-date gross margin.

YTD Total Revenue — (YTD Labor + YTD Direct + YTD
Reimbursable Amounts Spent)

Firms that do not allocate overhead show project results
on a gross margin basis.

Total YTD Hours The year-to-date labor hours spent for a project.

Total YTD Net Revenue The year-to-date revenue for a project.

Non-Labor Direct Expense + Reimbursable Expense

Total YTD Profit The year-to-date profit.

Revenue — Spent = Profit

Total YTD Received The year-to-date amount received for a project

Total YTD Revenue The year-to-date amount of revenue calculated for a
project.

Total YTD Unbilled The year-to-date amount of revenue not yet billed for a
project.

Revenue — Billed = Unbilled

Project Number The project to which the summary belongs.
Phase Number The phase to which the summary belongs.
Task Number The task to which the summary belongs.

Project Summary at Cost Entity
Use the Project Summary at Cost entity to create summary reports with project costing information.

The fields in the Project Summary at Cost entity are the same fields that are in the Project Summary at
Billing entity, except they use cost rates rather than billing rates. See the "Project Summary at Billing"
section on page 126 of this guide for the list of fields.
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Vendor Entity

Use the Vendor entity to create vendor reports. When you use this entity, report content is retrieved from
or calculated with fields from the following Vision database tables:

VE (Vendor)

VEAddress (Vendor Table - Addresses)

CFGfAPDiscount (System Setup Table - Accounts Payable Discount Codes)
CFGBillTaxes (Billing Setup Table - Tax Codes)

CFGCountry (System Setup Table - Countries)

CFGPrimarySpecialty (System Setup Table - Employee Primary Specialties)
CFGVendorStatus (System Setup Table - Vendor Status)

CFGVendorType (System Setup Table - Vendor Types)

Organization

The Vendor entity provides you with the following fields to add to custom reports:

Vendor Field Description

#Vendordata Sources When you add this field to a report, it counts the items that

were used to compile the information in a row on the report.

AccountNumber The account number of your customer account with this
vendor.
Active Company If you use the Multicompany feature in Vision, this is the

company that you have open when you run a report.

AddrCreatDate The date and time when the vendor address record was
created.

AddrCreateUser The user who created the vendor address record.

Address The vendor's address code.

Address1-Address4 The first, second, third, and fourth lines of the vendor's
address.

AddrModDate The date and time when the vendor address record was last
modified.

AddrModUser The last user who modified the vendor address record.

Category A letter that corresponds to the vendor type such as T

(Trade), C (Consultant), or E (Employee).

CategorylLabel The vendor type, such as Trade, Consultant, or Employee.

Custom Reports and Microsoft SQL Server® Reporting

Services

134



y

\ Contents of the Vision Report Model

Deltek kwwmore

Vendor Field Description

CheckPerVoucher A Y or N (Yes or No) value that indicates whether or not to
print a separate check for each voucher for the vendor.

City The vendor's city.

Country The vendor's country.

CreateDate The date and time when the vendor record was created.

CreateUser The user who created the vendor record.

DefaultTaxCode

The vendor's default tax code that is used when Enable tax
auditing feature check box is selected on the Tax Auditing
tab of Configuration » Accounting » Company Settings.

DefaultTaxCodeLabel

The tax code description to print on invoices. The value is
stored in the Description field of the CFGBIllTaxes table.

DisadvBusiness

A 'Y or N (Yes or No) value that indicates whether or not the
vendor is a disadvantaged business.

DiscCode

The default discount code for the vendor.

DiscCodelabel

The description for the vendor's discount code, such as
Discounts Taken, Discounts Applied, and Discounts Ongoing.

Fax The vendor's fax number.

FedID The vendor's federal taxpayer identification number.
GroupKey The vendor name and number.

HBCU A Y or N (Yes or No) value that indicates whether or not the

vendor has an HBCU (Historically Black Colleges and
Universities) Minority status.

MinorityBusiness

A Y or N (Yes or No) value that indicates whether or not the
vendor is a minority business.

ModDate The date and time when the vendor record was last modified.

ModUser The last user who modified the vendor record.

OHAccount The default account to use for overhead projects in data
entry.

Org The code for the vendor's organization. This is used for
sorting purposes only.

OrgName The name of the vendor's organization.

Custom Reports and Microsoft SQL Server® Reporting

Services

135



\ Delte Know more.
Do more.™
Contents of the Vision Report Model

Vendor Field Description

PayTerms A variable that indicates the default payment terms for the
vendor. Options are Number of Days, Hold, Next, or PWP
(Pay When Paid).

Phone The vendor's phone number.

Primaryind A Y or N (Yes or No) value that indicates whether or not the
address is the vendor's primary address.

Priorwork A Y or N (Yes or No) value that indicates whether or not the
vendor has done prior work for the organization.

Recommend A 'Y or N (Yes or No) value that indicates whether or not the
vendor has been recommended to do work for the
organization in the future.

RegAccount The default account to use for regular projects in data entry.

Req1099 A 'Y or N (Yes or No) value that indicates whether or not a
1099 form is required for the vendor.

SmallBusiness A 'Y or N (Yes or No) value that indicates whether or not the
vendor is a small business.

Specialtydesc The description of the vendor's business specialty that is
entered on the General tab of the Vendor Info Center.

State The vendor's state.

Status The vendor's status (code). Options are A—Active, |—
Inactive, and D—Dormant.

StatusLabel The label for the vendor's status—Active, Inactive, or
Dormant. The value is stored in the Label field of the
CFGVendorStatus table.

TaxCountryCode The two-character tax code for the country in which the

vendor is located.

TaxCountryCodeLabel The name of the country in which the vendor is located. This
value is stored in the Country field of the CFGCountry table.

TaxRegistrationNumber The vendor's tax registration number.
Total Disc Pct The discount percent for the vendor.
Total Disc Period The number of days within which payment must be received

for the discount to apply.
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Vendor Field Description

Total Last Year 1099 The 1099 amount for last year. The 1099 form for the vendor
should match this amount.

Total This Year 1099 The amount paid to the vendor since the last 1099
initialization.
Type The two-digit code for the vendor's primary specialty as

entered in the Specialty field of the Vendor Info Center. The
value is stored in the Type field of the VE table.

TypelLabel The description of the vendor's selected specialty as defined
in the Description field of the Vendor Primary Specialty
Code table. The description value is stored in the
Description field of the CFGPrimarySpecialty table.

vememo Any notes that are entered for the vendor record.

Vendor The vendor number.

VendorName The vendor name.

Website The vendor's Web site address.

WomanOwned A 'Y or N (Yes or No) value that indicates whether or not the

vendor is a woman owned business.

Zip The vendor's ZIP code.
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